Introduction

Welcome to the Pro Tools® | S3 studio controller and Ethernet AVB 4 in/6 out audio interface from Avid®. The S3 uses Avid’s high-speed EUCON™ (Extended User Control) control protocol to enable fully integrated control of Pro Tools and other EUCON-compatible audio and video applications via a 100 MB/s Ethernet connection. The same Ethernet connection also provides Ethernet AVB audio connections between the on-board audio I/O on the S3 and the workstation computer.

The S3, when connected to an E3 engine and up to four Stage 16 remote stage boxes, is also the central controller for the VENUE | S3L-X live digital mixing system.

See the VENUE | S3L-X System Guide for more information.

EuControl Software

EuControl lets your workstation computer find, link, and communicate with the S3 via the EUCON protocol. EuControl also lets you set preferences for and customize the controls on your S3. EuControl software must be installed on the workstation computer before you can use the S3 with your application.

Ethernet AVB Audio

(AVB-compatible Mac Running OS X 10.9.x and Higher Required)

Ethernet AVB audio is a high-fidelity, low-latency Ethernet audio protocol used to connect the on-board audio I/O on S3 to your Core Audio- and AVB-compatible workstation computer. AVB audio must be enabled on the workstation computer before you can use the I/O on the S3 with your applications. See S3 Audio I/O Connections for more information.
What’s Included

• S3 control surface
• Power supply with IEC cable
• Documentation pack, which includes the EuControl software Activation Card, S3 Welcome Letter, Health and Safety Guide and a warranty card

If you bought the S3 as part of a VENUE | S3L-X system, see the VENUE | S3L-X System Guide for information on what’s included.

Additional Required Equipment

• Shielded Cat 5e (350 MHz) or better Ethernet Crossover cable(s)

Optional Equipment

• A standard Ethernet router or switch (for control surface functionality only)
• A qualified AVB-compatible Ethernet switch (for audio I/O and control surface functionality)

System Requirements and Compatibility

One S3 control surface can be used with EuControl Software at a time. One S3 can be used in conjunction with the Pro Tools | Control app for iPad (not included) and one Pro Tools | Dock. When no Pro Tools | Dock is present, S3 can be used with one Artist Transport at a time.

Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For compatibility information and other resources, visit: www.avid.com/S3-Surface-Support

Registration

Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. By registering, you become eligible to receive the following:
• Technical support information
• Software update and upgrade notices
• Hardware warranty information

About This Guide

This guide covers using the S3 control surface with Pro Tools and other EUCON-compatible applications.
Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

🔍 Shortcuts show you useful keyboard or mouse shortcuts.

🔍 Cross References point to related sections in this guide and other Avid guides.

Hardware Switches on S3 Control Surface

The names of switches on the S3 control surface are in bold, such as Sel. The two Surface SHIFT switches on the S3 are indicated by bold text, in all-caps to distinguish it from references to the Multi Select/SHIFT Global Modifier switch and the Shift key on your computer keyboard.

Surface SHIFT switch (left) and the Multi Select/SHIFT switch (right)

Accessing Secondary Functions Using Surface SHIFT

The Surface SHIFT switches on the S3 are used in conjunction with other switches to access a secondary layer of functions. The secondary functions of some switches are highlighted in gray above the primary function (such as < Bank/Home, where Home is the secondary function). Other switches have secondary functions that are not labeled on the surface. Read this guide to learn how to access all secondary functions.

The following terminology is used to describe Surface SHIFT functions:

Example:

- “Press and hold the Surface SHIFT switch then press the Bank/Home switch”

is written as

- “Press Surface SHIFT + Bank/Home”
How to Use this PDF Guide

These are some useful features of this PDF:

• The Bookmarks on the left serve as a continuously visible table of contents. Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading. Click on a subject heading to jump to that page.
• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns into a finger. Then click to locate to that subject and page.
• Any text entry in blue is an active link. Click on the link to go to that section.
• Select Find from the Edit menu to search for a subject.

Resources

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. The following are just a few of the services and features available.

Account Activation and Product Registration

Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your purchase online, download software, updates, documentation, and other resources.

https://www.avid.com/account

Support and Downloads

Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on the User Conference.


Products and Developers

Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

https://www.avid.com/Products/index.html

Get Started Fast Video Tutorials

Watch video tutorials for Dock, S3, and other EuControl products on YouTube:

Get Started Fast with Pro Tools | S3 and Dock
Installation and Setup

This chapter shows how to get your S3 set up as a studio controller, and consists of the following steps:

- Connecting S3
- Installing EuControl Software
- Enabling EUCON in Pro Tools
- Confirming EUCON

Connecting S3

First, connect your S3 directly to your workstation computer (the computer running Pro Tools or other DAW), or connect to a router that is then connected to your workstation computer, then power on S3.

⚠️ Standard routers and switches can be used if you are using the S3 only as a control surface. However, to use the built-in AVB audio I/O on the S3, the S3 must be connected directly to the computer or to an AVB-compatible Ethernet switch. Visit www.avid.com/compatibility for information on compatible peripherals.

To connect your S3 to your workstation computer:

1. Connect the female end of the AC power cord into the power adapter and the male end into a power outlet. Make sure the AC power cord is pushed all the way into the adapter.

![Connecting the AC power cable to the power adapter](image)

2. Connect the DC output cable from the power adapter to the DC In jack on the back panel.

![Connecting the DC power output cable to the DC In jack](image)
3 Connect one end of an Ethernet Crossover cable into Network port A on the back panel of the S3.

4 Connect the other end of the Ethernet cable to an available Ethernet port on your computer, or to the computer’s Thunderbolt port using an Ethernet-to-Thunderbolt adapter.

5 If you want to connect the S3 to a local area network, or to connect an Artist Transport, connect the Ethernet cable to an Ethernet router or switch, and make sure the router or switch is powered on before powering on the S3.

6 If you are connecting to a Mac with two Ethernet ports, we recommend you use Ethernet 1 rather than Ethernet 2. However, if you want to use Ethernet 2, do the following on your computer:
   - On the workstation computer, go to System Preferences > EUCON.
   - Click the Network Interface pop-up menu and choose Ethernet 2.

7 Press the power switch on the back of the S3 to the “on” position. The faders jump and the LEDs blink during initialization.

8 When the S3 is finished initializing, confirm that the S3 is in Studio Mode, indicated by Studio Mode appearing in the 15th top-row encoder display.

9 Do one of the following depending on the S3’s current mode:
   - If the S3’s current mode does not appear in the two encoder displays after the S3 is powered on, the firmware on your S3 must be updated via VENUE Software 4.5 or higher. Connecting the S3 to an E3 engine with VENUE 4.5 or higher installed and powering on both devices automatically updates the firmware on the S3. See the What’s New in VENUE 4.5 Guide for more information.
   - If the S3 is in Studio Mode, proceed to Installing EuControl Software.
   - If Live Mode is shown in the display instead of Studio Mode, proceed to Toggling Studio and Live Modes.
Toggling Studio and Live Modes

The S3 operates in one of the two following modes:

**Studio Mode** Lets you use the S3 with your workstation computer after EuControl software has been installed. If the S3 is in Studio Mode and is connected to an E3 engine (for use in an S3L live mixing system), the S3 will not be recognized by any E3 engines in the network.

**Live Mode** Lets you use the S3 with an E3 engine as part of an S3L live mixing system. If the S3 is in Live Mode and is connected to a workstation computer with EuControl software installed, the S3 will not be recognized by EuControl on the workstation computer.

You can toggle the S3 between modes using the Application/Workstation switch.

**To toggle between Live and Studio modes:**

1. Power off your S3.
2. Press and hold the Application/Workstation switch, then press the power switch on the back of the S3 to the “on” position.
3. Keep holding the Application/Workstation switch until the two rightmost top row encoder displays (encoders 15 and 16) show Live Mode/Studio and OK, respectively.
4. Press the encoder under the display showing Live Mode/Studio once, so that the desired mode appears above and in larger text than the other mode in the display.
5. Press the encoder under the display showing OK. The S3 restarts automatically in the selected mode.
Installing EuControl Software

Next, install EuControl software on your workstation computer. An Internet connection is required to download EuControl.

To install EuControl software:

1. Visit www.avid.com/account and log into your Avid account (or create an account if you don’t already have one) to download the EuControl installer for your workstation computer’s platform (Mac or Windows).

2. When download is complete, locate the EuControl installer on your computer and double-click it to mount it (DMG on Mac) or uncompress it (ZIP for Windows).

3. In the resulting folder, locate and double-click the Install_EuControl file.

4. Follow the on-screen instructions to complete the installation.

5. When installation is complete, click Quit (Mac) or Finish (Windows). EuControl software on your computer launches automatically and is running when its icon appears:

   **Mac** Wait up to 60 seconds. A lit EuControl icon in the menu bar indicates correct installation and your surface is attached in EuControl.

   ![Lit EuControl icon in the Mac menu bar](image)

   **Windows** Wait up to 60 seconds. A lit EuControl icon appears in the system tray at the bottom of the screen. If you don’t see the EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons.

   ![Lit EuControl icon in the hidden icons view of the Windows system tray](image)

6. If the lit EuControl icon does not appear, do any of the following:
   - See Add to add S3 manually.
   - Click the EuControl icon in the menu bar (Mac) or right-click the choose Restart EUCON Applications (see Restart EUCON Applications for more information).
   - Shut down S3 and your computer, then turn them on (S3 first, then the workstation computer).
   - See www.avid.com/S3-Surface-Support for the most current troubleshooting information.

7. Proceed to Updating S3 Firmware.
Updating S3 Firmware

After installing EuControl, make sure your S3 is running the latest firmware. The firmware is provided within EuControl, so an Internet connection is not required.

To update S3 firmware:

1. Click (Mac) or double-click (Windows) the EuControl icon and select EuControl Settings.

2. If necessary, click Surfaces to display the Surfaces tab.

3. Click Avid S3 in the My Surfaces list so it is highlighted.

   "If S3 does not appear in the My Surfaces list, add it manually. See Add." 

4. Click Update Firmware. If the Update Firmware dialog shows a message that the surface is up to date, no further action is necessary.

5. If the firmware needs to be updated, follow the instructions in the Update Firmware dialog box to proceed, and make sure to observe the following guidelines when updating firmware:
   • Ensure that S3 is connected to a trustworthy power source.
   • Do not power off the S3 during the update or attempt to interrupt the update.

   The status of the firmware update is shown on the S3 displays as well as in the EuControl dialog.

6. Click Done when the firmware update is complete, then proceed to Enabling EUCON in Pro Tools.
Enabling EUCON in Pro Tools

When you first connect your S3, you must enable EUCON in Pro Tools, EUCON subsequently remains enabled in Pro Tools unless you disable it. To enable EUCON in other DAWs, see the documentation provided by the manufacturer.

To enable EuControl in Pro Tools:

1. Launch Pro Tools. If the Quick Start dialog appears, close it.
2. Choose Setup > Peripherals, and click the Ethernet Controllers tab.
3. Select Enable EUCON.

4. Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do not apply to EUCON. Pro Tools scans your system until it identifies attached EUCON-compatible hardware. When Pro Tools finishes scanning your system, your controllers are ready to use with Pro Tools.

5. Proceed to Confirming EUCON.

⚠️ If you have recently updated from an earlier version of Pro Tools, go to Installing Appsets for EuControl Products.
Confirming EUCON

To confirm installation and communication:

1. Make sure you have enabled EUCON.
2. Open a session if one is not already open.
3. Verify that the channel strip displays above the bottom row of 16 encoders (the Channel Encoders) on the S3 show the track names for the first 16 tracks in the Pro Tools session.
4. In the Pro Tools Mix window, verify that the names of the tracks currently banked to the channel strips on S3 are highlighted with blue-green borders.

Powering-On Your System After Initial Setup

After the initial installation and setup, your system must be powered on in a specific order, as follows:

1. If connecting to a router, connect S3 to the router, connect the router to the workstation computer, and power on the router.
2. If connecting directly, connect S3 to the workstation computer.
3. Power on the S3.
4. Confirm that S3 is in Studio Mode. Enable Studio Mode if Studio Mode is not enabled (see Toggling Studio and Live Modes).
5. Once S3 is finished initializing, power on the workstation computer.

💡 If the S3 is not recognized by EuControl on your workstation computer (for example, because you powered S3 on after powering on the workstation computer), click the unlit EuControl icon in the menu bar (Mac) or System tray (Win) and choose Restart EUCON Applications...to relaunch EuControl and re-initiate the connection.
Connecting a Second Workstation

The S3 can control applications running on a second computer that is connected to the same network as the primary network, referred to in this guide as a workstation. If EuControl is running on the same workstation as all your audio/video applications you can skip these instructions.

To be able to control a second workstation:

1. Quit (Mac) or Exit (Windows) Pro Tools and any other EUCON applications running on any of your workstations.
2. Transfer the EuControl installer onto the second computer. After downloading, make sure the installer is mounted (DMG on Mac) or uncompressed (ZIP for Windows).
3. In the Extras folder, double-click the Install EuCon Workstation (Mac) installer and follow the instructions to install the EuControl Workstation software.
4. When installation has finished, go to Spotlight (Mac) or Search (Windows), and type “MC Client” to locate the application.
5.Launch MC Client to enable control of the secondary workstation.
6. On the primary workstation, do each of the following:
   - Open EuControl Settings, go to the Workstations tab, and click to enable Enable External Workstations. Follow the prompt and wait until EUCON applications restart. You must also manually relaunch your DAW.
   - Go to System Preferences > EUCON (Mac) or Control Panel > EUCON (Windows).
   - Click the Network Interface selector and choose the port used for your EUCON network connection (such as Ethernet 1).
7. On the secondary workstation, do each of the following:
   - Go to System Preferences > EUCON (Mac) or Control Panel > EUCON (Windows).
   - Make sure the Network Interface selector shows the correct network port for your EUCON connection.
   - If it is not already enabled, click to enable Enable as External Workstation. Follow the prompt and wait until EUCON applications restart. You must also manually relaunch your DAW.
8. Open the EuControl Settings window by doing either of the following:
   - On Mac, click the EuControl icon on the taskbar and select EuControl Settings.
   - On Windows, double-click the EuControl icon in the system tray and select EuControl Settings. If you don’t see the EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons, then double-click the EuControl icon.
9. In EuControl Settings, go to the Workstations tab.
10. Select your secondary workstation in the All Workstations list, then click Add to add it to the My Workstations list.
You can now switch between workstations by doing either of the following:

- On the Dock, S3, or other Artist Series media controller, press the **Workstation** switch. For example, on the S3 press `SHIFT+Application/Workstation`.
- In the Workstations tab of EuControl Settings, select the desired workstation in the My Workstations list and click **Attach**. If you are using the Control app without any other Artist Series controllers, you must use this method to switch workstations.

See **Workstations** for information on attaching and detaching workstations.

---

**Connecting a Footswitch**

The S3 has a 1/4-inch footswitch input on the back panel, which can be used to punch in and out of recording in your DAW, or for engaging talkback. See **Footswitch** for more information on configuring the footswitch.

![Footswitch input on the back of S3](image)
Installing Appsets for EuControl Products

Avid provides a set of pre-configured Soft Key commands (Appset) for Pro Tools | Dock, Pro Tools | Control, Pro Tools | S3, and Artist series control surfaces. Perform the tasks in this section to make sure you get the latest Appset functionality when using your controller(s) with Pro Tools and other EUCON™-aware applications.

To download the latest Appset:

1. Visit [www.avid.com/account](http://www.avid.com/account), log into your Avid account and download the “EuControl Appsets vX.X.zip” to your computer.
   
   Note: To access this file you must first register using the Control app, or using the EuControl Software Activation Card included with the Dock.
   
   • As an alternative, visit EuControl Appsets and download the “EuControl Appsets vX.X.zip” from our Knowledge Base.

2. When download is complete, locate the downloaded “EuControl Appsets vX.X.zip” on your computer and double-click it to expand it (Mac) or uncompress it (Windows).

To install the latest Appset:

1. On your computer, go to the following locations:
   
   • On Mac, go to: /Library/Application Support/Euphonix/UserSets/MC2User/MC_USER_SET_Root
   
   • On Windows, make sure “Show hidden files and folders” is enabled, and go to:
     C:Users<enter your username here>\AppData\Roaming\Euphonix\UserSets\MC2User\MC_USER_SET_Root\n
2. If an XML file is located in this folder, move the file to a different location and take note of that location as you might want to use it in the future.

3. In the “EuControl Appsets vX.X” folder you downloaded and expanded, locate the appset files for your DAWs.
   
   For example, for Pro Tools 12, locate the files called Pro Tools 12Mac.xml or Pro Tools 12Win.xml. If you are running Pro Tools 11 instead of Pro Tools 12, locate the file Pro Tools 11Mac.xml or Pro Tools 11Win.xml.

4. Move the desired .xml file into the MC_USER_SET_Root folder.

5. Restart all EUCON applications by doing the following:
   
   • On Mac, click the EuControl icon on the taskbar and select Restart EUCON Applications, then click Yes.
   
   • On Windows, click the EuControl icon in the Task or System tray (Windows) and select Restart EUCON Applications, then click Yes. Unused icons will be shown in the Hidden icons view.

6. Your EuControl surface will now recognize the new Appset.
S3 Surface Controls Overview

This section provides an overview of the surface controls on the S3 when using S3 with EUCON-compatible applications. For specific S3 workflows, see Using S3 with Pro Tools.

S3 top panel

1 – Channel Strips
2 – Channel Strip Displays
3 – Assignable Channel Encoders
4 – Channel Encoder Assignment Switches
5 – Fader Banking Controls
6 – Left Control
7 – Channel Control
8 – View and Arrow Switches
9 – Application/Workstation Switch
10 – Right Control
11 – Solo Clear and Mix to Monitors Switches
12 – Surface SHIFT
13 – Modifier Switches
14 – Touchstrip
Channel Strips

S3 provides 16 channel strips, each with a display, an Assignable Channel Encoder (each with its own encoder Sel and In switches), a Solo switch, a Mute switch, a 100mm motorized touch-sensitive fader, a channel select (Sel) switch, a record engage (Rec)/Automation Mode (A) switch, and a level meter.

Channel Strip Display
See Channel Strip Displays.

Assignable Channel Encoder
See Assignable Channel Encoders.

Solo
The Solo switch lights yellow when that track is soloed.

Mute
The track is muted (off) when the strip Mute switch is lit, and is on (unmuted) when not lit.

Fader
The fader controls the level for the track assigned to the channel strip, or the parameter assigned to the Channel Encoder if Flip to Faders is engaged. It is motorized so it reflects changes made in the application, such as automation. It is also touch sensitive, which some applications use for automation.

- When the Select by Touch General preference is selected in the EuControl Settings application (see Select by Touch), touching a fader selects that track in the application and attentions it on that strip. This is the same as pressing the fader Sel switch.
- Holding down the Default/ALT switch and touching a fader sets it to unity gain.

Channel Sel and Rec Switches
Each channel strip features a channel Sel, a channel Rec switch, and an automation mode switch (A), which operate as follows:

Sel Selects that track in the application, and attentions it for editing in the Channel Encoders when Channel Mode is enabled (see Channel Encoder Modes), and in Channel Control (see Channel Control). A line under the track name in a channel strip display indicates the track is attentioned.

💡 In Pro Tools and other applications, multiple tracks can be selected, but only one channel can be attentioned. In this case, the attentioned track is the last one selected.

Rec Record-enables a track in the application.

- In Pro Tools, the Rec switch flashes red to indicate that track is enabled (armed) for recording, and is lit solid when recording is in progress.
- Pressing a lit Rec switch disables that track for recording.

A (Surface SHIFT + Rec) Changes the automation mode for a track. The desired automation mode appears in the bottom right-hand corner of the channel strip display or on-screen.

💡 You can also use the Function (F1–F16) switches to change track automation modes. See Working with Automation.
Channel Strip Displays

At the top of each channel strip is an Organic Light Emitting Diode (OLED) display. When S3 is first powered on, the Channel Encoders are in Normal Mode (see Channel Encoder Modes), and each display shows track information as follows:

1 – Meter Shows clip, peak, and normal values. It can show mono, stereo, or surround tracks.
2 – Track Name Shows the track name as it appears in the application. When a fader is touched, it shows the value of the fader. After releasing the fader it reverts to showing the track name.
3 – Track Number Shows the track number relative to its position in the application.
4 – Parameter Name Shows the name of the parameter currently assigned to the corresponding Channel Encoder. When an encoder is touched, it shows the value of the parameter. After releasing the encoder it reverts to showing the parameter name.
5 – Encoder Position Shows the relative setting of the control for the currently assigned parameter.
6 – Automation Mode Shows the track’s current automation mode setting, as follows:
   - blank = automation is off
   - r = read
   - w = write
   - rw = read/write

For more information on working with automation on the S3, see Working with Automation.

7 – Attention Indicator Indicates that the corresponding track is the attentioned track. Any parameters adjusted using the Channel Encoders in Channel Mode (see Channel Encoder Modes) and using Channel Control apply to the attentioned track (see Channel Control).

Display Sleep

To preserve display life, the channel displays enter sleep mode when not in use.
Assignable Channel Encoders

Each channel strip has one touch-sensitive, continuously rotating encoder for adjusting parameters as assigned by the Channel Encoder Assignment switches (see Channel Encoder Assignment Switches). Each encoder can also be pressed, which is typically used to access sub-menus. Each encoder also has corresponding Sel and In switches.

- A Channel Encoder Sel switch assigns a secondary function of the displayed parameter to the corresponding Channel Encoder. For example, engaging the Sel switch for an encoder controlling EQ frequency assigns Q (bandwidth) to that encoder.
- A Channel Encoder In switch toggles two-state parameters, such as turning an individual EQ Band on/off.

Channel Encoder Modes

The Channel Encoders operate in either Normal Mode or Channel Mode. The channel displays shows the current channel mode.

Normal Mode

In Normal Mode, each Channel Encoder controls the same parameter for every track on the channel strips. A line appears under the attentioned track’s name in the display.

![Channel displays in Normal Mode, showing “Snare” as the attentioned track](image)

Channel Mode

In Channel Mode, the 16 Channel Encoders control up to 16 different parameters for the attentioned track. In Channel Mode parameter names and value are highlighted in each channel display. For the attentioned track, track name as well as parameter and value are highlighted.

![Channel displays in Channel Mode, showing “Snare” as the attentioned track](image)

Channel Mode is useful for editing EQs and plug-ins that have many parameters.

Basic Channel Encoder Use

When S3 is first powered on, the Channel Encoders are in Normal Mode and Pan is assigned to the Channel Encoders by default. Each Channel Encoder controls pan for its corresponding track on the strip.

To quickly access pan control on the Channel Encoders in Normal Mode:

- Press the Pan Channel Encoder Assignment switch.

To enable Channel Mode:

1. Press a Channel Sel switch to attention that track, then press SHIFT + Flip.
2. Press the desired channel Encoder Assignment switch
3. To exit Channel Mode, press Shift + Flip again.

💡 Pressing the EQ Channel Encoder Assign Switch automatically enables Channel Mode as well.
Channel Encoder Assignment Switches

The Channel Encoder Assignment switches assign sets of adjustable parameters, called Knob Sets, to the Channel Encoders. A Knob Set is an array of controls used by EuControl-compatible applications to control plug-ins, EQs, dynamics, aux sends, and other processing functions using the controls on the S3. Some of these Knob Sets also have sub-menus.

One of the switches is always selected, and the associated parameters are assigned to the Channel Encoders until another Channel Encoder Assignment switch is pressed. When S3 is first powered on, Pan is selected by default.

The labels next to each Channel Encoder Assignment switch indicate the parameters that can be assigned to the Channel Encoders. The text in white represents a switch’s primary function, and the text in black represents a switch’s secondary function. Secondary functions are accessed by pressing and holding the Surface SHIFT switch (see Surface SHIFT) then pressing the desired Channel Navigation switch.

The following switches are provided:

**Input** Assigns hardware input parameters such as input routing, mic gains, phantom power, and other application-specific parameters to the Channel Encoders.

**Insert** Assigns the top-level Insert Knob Set to the Channel Encoders. When Insert is pressed, in each channel display for all currently banked tracks the first insert slot (a) is shown, or a plug-in is shown if one is inserted. Pressing a Channel Encoder under the display showing the plug-in you want to adjust enables Channel Mode on the Channel Encoders, and the Knob Set for the selected plug-in is assigned to the 16 Channel Encoders for editing.

- Press the Page > Channel Encoder Navigation switch to access the next plug-in.
- Press the Back Channel Encoder Navigation Switch to return to the Channel Encoders to the top-level Inserts Knob Set. Or, you can simply press another Channel Encoder Assignment switch to navigate directly to another Knob Set.

**Dyn** Assigns the top-level Dynamics Knob Set to the Channel Encoders. Operation is similar to the Inserts Knob Set, except only the first inserted Dynamics plug-in on the channel is displayed and accessed.

- In the Dyn Knob Set, parameter mappings to the Channel Encoders are standardized across dynamics plug-ins. For example, the threshold controls for two compressor plug-ins from different manufacturers appear on the same encoder.

Use the Audio Control Encoders to control the S3’s built-in I/O. See S3 Audio I/O Connections for more information.

In the Insert Knob Set, parameters are mapped to the Channel Encoders according to the manufacturer’s specifications. Parameter mapping can vary between plug-ins, even of the same type.

The text on the switch itself indicates the parameter that can be assigned to the Channel Encoders when using S3 as part on an S3L live system.

The following switches are provided:

- **Input** Assigns hardware input parameters such as input routing, mic gains, phantom power, and other application-specific parameters to the Channel Encoders.

- **Insert** Assigns the top-level Insert Knob Set to the Channel Encoders. When Insert is pressed, in each channel display for all currently banked tracks the first insert slot (a) is shown, or a plug-in is shown if one is inserted. Pressing a Channel Encoder under the display showing the plug-in you want to adjust enables Channel Mode on the Channel Encoders, and the Knob Set for the selected plug-in is assigned to the 16 Channel Encoders for editing.

- Press the Page > Channel Encoder Navigation switch to access the next plug-in.

- Press the Back Channel Encoder Navigation Switch to return to the Channel Encoders to the top-level Inserts Knob Set. Or, you can simply press another Channel Encoder Assignment switch to navigate directly to another Knob Set.

- **Dyn** Assigns the top-level Dynamics Knob Set to the Channel Encoders. Operation is similar to the Inserts Knob Set, except only the first inserted Dynamics plug-in on the channel is displayed and accessed.

- In the Dyn Knob Set, parameter mappings to the Channel Encoders are standardized across dynamics plug-ins. For example, the threshold controls for two compressor plug-ins from different manufacturers appear on the same encoder.
**Aux** Assigns sends on the Channel Encoders.

- In Normal Mode, the first send is displayed, and pressing the **Page >** Channel Encoder Navigation switch assigns the next set of sends to the encoders.
- In Channel Mode, up to 16 sends for the currently selected channel can be accessed at once.

**Group** Displays the Group Knob Set to configure group or control group (VCA) membership.

- In Normal Mode, the first group is displayed, and pressing the **Page >** Channel Encoder Navigation switch displays the next group if applicable.
- In Channel Mode, up to 16 groups for the currently selected channel can be accessed at once.

**EQ** Assigns the top-level EQ Knob Set to the Channel Encoders. Operation is similar to the Inserts Knob Set, except only the first inserted EQ plug-in on the channel is displayed and accessed.

> *In the EQ Knob Set, parameter mappings to the Channel Encoders are standardized across EQ plug-ins. For example, high band gain controls for two EQ plug-ins from different manufacturers appear on the same encoder.*

**Pan** Displays the Pan Knob Set to configure stereo or surround panning. Pan controls are not available for tracks with mono or no output path assignments.

**Mix (Surface SHIFT + Pan/Mix)** Displays the Mix Knob Set to configure track output routing.

**Flip** Toggles what is currently assigned to the knobs (such as pan or send parameters) to the faders. A vertical double arrow appears in the channel strip display when the faders and knobs are flipped. Press **Flip** again to toggle the faders and knobs back to normal. You can use Flip mode with Aux sends, for example, to quickly set up headphone mixes using the faders.

**Channel (Surface SHIFT + Flip/Channel)** Toggles the Channel Encoders between Normal Mode (unlit Channel switch) and Channel Mode (lit Channel switch). In Normal Mode, the attentioned track name is underlined to show which track’s parameters will be expanded in Channel Mode.

**Channel Encoder Navigation Switches**

Since a Knob Set may have more parameters than encoders, use these switches to navigate through available parameters.

**Back** Returns to the previous Knob Set. Press **Back** repeatedly to back out of all sub-menus and display the top of the current Knob Set.

**Source** Shows the input sources for the currently banked channels in the channel strip displays.

**< Page, Page >** Assigns the previous or next set of parameters to the Channel Encoders. The switches light when there is a previous or next set to go to. For example, if Send A is assigned to the Channel Encoders, pressing **Page >** assigns Send B to the Channel Encoders.
Fader Banking Controls

Bank tracks to the channel strips using the Bank and Nudge switches. Home and End are shortcuts to the first and last banks, respectively.

Bank and Nudge

The Bank and Nudge switches change which tracks are assigned to the channel strips, as follows:

- `< Nudge` Banks tracks one track to the left. If tracks 2–17 were banked to channel strips 1–16, tracks 1–16 are now banked to strips 1–16.
- `Nudge >` Banks tracks one track to the right. If tracks 1–16 were banked to channel strips 1–16, tracks 2–17 are now banked to strips 1–16.
- `< Bank` Banks 16 tracks to the left. If tracks 17–32 were banked to strips 1–16, tracks 1–16 are now banked to strips 1–16. Pressing the switch again does nothing because the first bank is already shown.
- `Bank >` Banks 16 tracks to the right. If tracks 1–16 were banked to strips 1–16, tracks 17–32 are now banked to strips 1–16.

Mixer and Close

Not all applications support these switches.

- **Mixer (Surface SHIFT+ `< Nudge/Mixer`)** Toggles Mix and Edit windows in Pro Tools.
- **Close (SHIFT + Nudge >/Close)** Closes any open window in the application.

Home and End

- **Home (Surface SHIFT + `< Bank/Home`)** Banks tracks 1–16 to the channel strips.
- **End (Surface SHIFT + Bank >/End)** Banks the last set of tracks to the strips.
Switches A–F

By default, these switches let you recall custom fader banks and layouts, as created and stored using the Layouts and Assign tabs of the EuControl Settings application. You can recall up to 12 custom fader layouts using switches A–F. A–F recall mixer layouts 1–6. The Shift layer (Surface SHIFT + Bank A–F) recalls layouts 7–12. See Storing and Recalling Custom Layouts for more information.

You can also customize these switches in EuControl. See Soft Keys for more information.

OK and Cancel Switches

Multi Assign Performs the Do to Selected command. For example, use this to create a send or insert a plug-in on all selected tracks. See Assigning Sends for an example.

Pressing and holding Surface SHIFT + Multi Assign performs the Do to All command. Use this to create a send or insert a plug-in on all tracks in the session.

OK Confirms and closes dialogs, and is the equivalent of pressing the Enter key on a computer keyboard.

Cancel Closes dialogs without making any changes, and is the equivalent of pressing the Escape key on a computer keyboard.

User Saves the current session.

To save the current session:

1 Press User.

2 Press User again to confirm, or press Cancel to not save.
Channel Control

The top row of 16 encoders and associated navigation switches is called Channel Control. Channel Control lets you adjust a variety of parameters for the currently attentioned track. Channel Control and the bottom-row Channel Encoders operate independently, so you can adjust two sets of parameters for a single channel. You can also access controls for the S3’s built-in I/O using Channel Control (see S3 Audio I/O Connections for more information).

Each Channel Control Encoder features a corresponding display, a select (Sel) switch, an In switch, and a color-by-function LED. Four Channel Control Navigation switches are provided for navigating through parameters.

Channel Control showing the top-level Channel Control Knob Set (I/O controls are hidden)

Channel Control Navigation Switches (Left)

These switches let you navigate through the available pages of Channel Control parameters. An In (enable/bypass) switch is also provided.

The following switches are provided:

**Back/Top** Backs out of the currently assigned Knob Set.

Surface SHIFT + Back/Top returns Channel Control to the top-level Channel Control Knob Set.

**In** Toggles in/out whatever is assigned to the Channel Control Encoders, such as sends and plug-ins. A lit switch indicates that the send or plug-in is in.

**< Page, Page >** Assigns the previous or next page of parameters. These switches light when there is a previous or next set to go to.
Channel Control Navigation Switches (Right)

These switches provide access to Config mode and the controls for the built-in I/O in Channel Control.

**Config switch and I/O Controls**

**Config** Enables Config mode on the Channel Control Encoders, letting you assign plug-ins to tracks, and assign track and send input and output paths. See *Routing Track Input/Output* and *Assigning Plug-Ins* for more information.

**< Page, Page >** Lets you show/hide the Audio Control (controls for the built-in I/O) on the Channel Control Encoders when pressed simultaneously. I/O controls are hidden by default. See *Accessing Audio Control on the S3* for more information.

**Basic Channel Control Use**

When S3 is first connected to a session in your DAW, the top-level Knob Set for the currently selected channel is shown in the Channel Control displays. The types of parameters that can be spilled to the Channel Control Encoders vary depending on the type of channel selected (audio track, instrument track, etc.).

**To adjust parameters using Channel Control:**

1. Select a track. If multiple channels are selected, the last selected track is the attentioned track, and is the targeted channel for any changes made in Channel Control. The name of the attentioned track and its track number is shown in the leftmost Channel Control display.

2. Press a Channel Control Encoder under the display showing the parameters you want to adjust. For example, to adjust an EQ plug-in inserted on the currently selected channel, press the Channel Control Encoder under the display showing EQ.

3. To go to a different Knob Set, press the **Back** Channel Control Navigation switch to return to the top-level Knob Set, then press another Channel Control Encoder.

**Channel Control LED Color-Coding**

Channel Control LEDs are color-coded by function, as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Color</th>
<th>Function</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Turquoise</td>
<td>Sends</td>
<td>Yellow</td>
</tr>
<tr>
<td>Input</td>
<td>Red</td>
<td>Pan</td>
<td>Blue</td>
</tr>
<tr>
<td>Dyn</td>
<td>Green</td>
<td>Groups</td>
<td>Orange</td>
</tr>
<tr>
<td>EQ</td>
<td>Purple</td>
<td>Mix</td>
<td>Amber</td>
</tr>
</tbody>
</table>
View and Arrow Switches

By default, these switches provide recall of Memory Locations, and zoom controls. You can also customize these switches in EuControl. See Soft Keys for more information.

▲ ▼ Adjust vertical zoom (track height) of all tracks in the Timeline display of the Edit window.
◄ ► Adjust horizontal zoom (zoom in/out) of all tracks in the Timeline display of the Edit window.

Application/Workstation Switch

This switch lets you cycle through the available applications and workstations.

Application Toggles between the two most recently used open applications. Hold down Application and press Bank > to cycle through all open applications. Hold down the Application key and press < Bank to cycle through applications in the opposite direction.

Workstation (Surface SHIFT + Application/Workstation) Attaches the S3 to another workstation, where applicable. S3 can control applications running on a second computer, referred to in this guide as a workstation. You must first use EuControl to create a list of workstations that this key switches between. See Workstations for more information.

Solo Clear and Mix to Monitors Switches

These switches provide the following functions:

Solo Clear Clears any currently soloed channels.

Mix to Mons Is not currently implemented for DAW use.
Right Control

By default, switches F1–F8 (F9–F16) provide control over the automation mode for one or more selected tracks in two banks of switches. For more information on working with automation on the S3, see Working with Automation.

You can also customize these switches in EuControl. See Soft Keys for more information.

The following table shows the default function of each switch in this section.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Automation Function</th>
<th>Switch</th>
<th>Automation Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Write</td>
<td>F2</td>
<td>Read</td>
</tr>
<tr>
<td>F3</td>
<td>Touch</td>
<td>F4</td>
<td>Automation Off</td>
</tr>
<tr>
<td>F5</td>
<td>Latch</td>
<td>F6</td>
<td>Automation Match</td>
</tr>
<tr>
<td>F7</td>
<td>Trim</td>
<td>F8</td>
<td>Automation Window</td>
</tr>
<tr>
<td>F9</td>
<td>Preview</td>
<td>F10</td>
<td>Write to All/Selected</td>
</tr>
<tr>
<td>F11</td>
<td>Punch Preview</td>
<td>F12</td>
<td>Write to Start</td>
</tr>
<tr>
<td>F13</td>
<td>Capture</td>
<td>F14</td>
<td>Write to End</td>
</tr>
<tr>
<td>F15</td>
<td>Punch Capture</td>
<td>F16</td>
<td>Write to Next</td>
</tr>
<tr>
<td>9–16</td>
<td>Toggles switches between banks F1-F8 and F9-F16</td>
<td>Show Me (Eye Icon)</td>
<td>Opens EuControl Settings &gt; Soft Keys &gt; Right Control section</td>
</tr>
</tbody>
</table>

To set the automation mode on a single track:

- Press and hold the Function switch for the desired Automation Mode, then select a channel.

To set the automation mode on multiple tracks:

1. Select multiple channels.
2. Press and hold Multi-Select/SHIFT+ ALT, then press the switch for the desired Automation Mode.

The Function Switch LED lights whenever its respective automation mode is selected. In certain automation modes such as Write, the LED flashes.
Surface SHIFT

Some switches have secondary functions, highlighted in gray above the primary function (such as `< Bank/Home, where Home is the secondary function). To access these secondary functions, use either of the two Surface SHIFT switches located at the lower-left and lower-right sides of the console surface. SHIFT can be engaged momentarily or latched on.

![Surface SHIFT switch]

**To engage Surface SHIFT momentarily:**
- Press and hold the Surface SHIFT switch.

**To latch SHIFT on:**
- Press and release either Surface SHIFT switch. Surface SHIFT is lit when engaged; press either Surface SHIFT switch to unlatch.

Modifier Switches

The Modifier switches provide frequently used shortcuts that can be applied to console actions and software screen interactions. In Pro Tools, these switches duplicate the function of the Pro Tools computer keyboard modifiers.

![Global Modifier switches]

**Multi Select/SHIFT** Duplicates the function of the Shift key on the computer keyboard.

**Default/ALT** Duplicates the function or the Option key (Mac) or the Alt key (Windows) on the computer keyboard.

**Fine/CTRL** Duplicates the function of the Control key (Mac) or the Windows key (or Start) on the computer keyboard.

**Command** Duplicates the function of the Command key (Mac) or the Control key (Windows) on the computer keyboard.

Touchstrip

By default, the four Touch strip Zones provide transport controls. You can also customize these switches in EuControl. See Soft Keys for more information.

![Transport controls]

**To use the Transport:**
1. Press and hold Surface SHIFT.
2. Press the following Zones for the various transport functions:
   - **1 (Rewind)** Rewinds until released.
   - **2 (Fast Forward)** Fast forwards until released.
   - **3 (Play/Stop)** Engages play when the transport is stopped; stops the transport when play is engaged.
   - **4 (Record Arm)** Arm the transport for recording.
Using S3 with Pro Tools

This section provides information on the latest Appset functionality when using S3 with the latest version of Pro Tools. If you have updated from a previous version of Pro Tools, see Installing Appsets for EuControl Products

Track Basics

This section shows how to select, attention, and route tracks to outputs.

Selecting and Attentioning Tracks

You can select and attention tracks using channel Sel switches. You can use the Modifier switches to select multiple channels. When multiple channels are selected, the last selected track is the attentioned track.

To select a track:

- Press any channel Sel switch. The track is selected in Pro Tools, and that track is attentioned on the S3.

To select all tracks:

- Hold the Default/ALT Modifier switch and press any unlit channel Sel switch.

To deselect a track:

- Hold Command and press a lit channel Sel switch.

To deselect all selected tracks:

- Hold Default/ALT switch and press any lit channel Sel switch.
To select a range of tracks (multi-select):
1. Press the first track’s channel Sel switch (usually the leftmost track you want to include in the selection).
2. Hold Multi Select/SHIFT and press Sel on the last (right-most) track. All tracks between the two are selected.

To select non-adjacent tracks (add to a selection):
1. Press the channel Sel switch to select any track.
2. Hold Command and press an unlit channel Sel switch.

Modifier switches

Adjusting Track Volume and Pan

To adjust track volume:
- Adjust the fader for that track.

To adjust track pan:
1. If unlit, press Pan so that it stays lit.
2. Rotate the encoder below the name of the track you want to pan. Stereo tracks default to left pan.
3. To adjust right side pan on stereo tracks, press the lit Page > Channel Encoder Navigation switch and rotate the encoder for the desired track. The display shows R Pan above stereo tracks and the < Page key lights.
4. To return to left side pan, press the lit < Page switch.

To reset pan to 0 (center):
1. If unlit, press Pan so that it stays lit.
2. Press the Channel Encoder below the name of the track you want to reset to center.

The standard Pro Tools modifier for parameter reset by holding Option (Mac) or Alt (Windows) can also be used to reset controls. For example, holding Option (Mac) or Alt (Windows) and touching a fader resets the fader to 0/unity.
**Surround Panning on S3**

Use the Channel Encoders or Channel Control to control multichannel pan parameters.

**To pan in surround using the Channel Encoders:**
1. Select a track assigned to a multichannel output path (such as a 5.1 or 7.1 output path).
2. Press Pan. The first Multichannel pan parameters such as Front Left/Right (for 5.1 outputs) appear on the Channel Encoders.
3. Press the lit Page switch to show other available pan parameters.
4. Rotate an Encoder to adjust the selected parameter.
5. To reset a parameter to its default setting, press the Encoder for that parameter.

**To pan in surround using Channel Control:**
1. Select a track assigned to a multichannel output path (such as a 5.1 or 7.1 output path).
2. Press the Channel Control Encoder under the display showing Pan. Multichannel pan parameters appear across Channel Control.

**Record Enabling Tracks**

This section explains how to use track and deck record enable commands.

**To record enable a track:**
- Press the channel Rec switch. The switch flashes red.

💡 You can swap the primary and SHIFT functions of the Rec/A switch in the General tab of EuControl Settings.

**To record enable additional tracks:**
- Hold SHIFT/Multi Select and press additional channel Rec switches.

💡 You can set Pro Tools Preferences for latching record enable, so you don’t have to hold the Shift key to record enable additional tracks. For more information, see the Pro Tools Reference Guide.

**To record enable all tracks:**
- Hold Alt then press a channel Rec switch.

**To use the Touchstrip to control the transport for recording:**
1. Press Surface SHIFT + Touch Strip Zone 4 to arm the transport. The Record icon in Pro Tools flashes red.
2. Press Surface SHIFT + Touch Strip Zone 3 to commence recording.
3. To stop recording, press Surface SHIFT + Touch Strip Zone 3 again.
4. To disarm the transport, press Surface SHIFT + Touch Strip Zone 4.

**Flipping Encoder Parameters to Faders**

S3 lets you “flip” parameters mapped to the Channel Encoders to the faders and the track level control to the Channel Encoder. The following example shows how to flip pan to faders. Flip also works with sends and plug-ins.

**To flip pan to faders:**
1. Select a track.
2. Press Pan.
3. Press Flip.
4. Adjust a fader to adjust pan for the corresponding track. Adjust the Channel Encoder to adjust track level.
5. Press Flip again to flip parameters back to the Channel Encoders.
Routing Track Input/Output

You can route track I/O using the Channel Encoders or Channel Control.

Using the Channel Encoders

To route track input or output using the Channel Encoders:

1. Select a track. If several tracks are selected, make sure the track you want to adjust is attentioned.

2. Do either of the following:
   - To assign track input, press **Input**.
   - To assign track output, press **Surface SHIFT + Pan/Mix**.

3. Press the Channel Encoder for the track you want to assign. Channel Mode is enabled, and the leftmost channel displays show the available types of input sources (interface, bus, or plug-ins) or output destinations (output or bus) for the selected track.

4. Under the display showing the desired input or output type, rotate the corresponding Channel Encoder until the desired input or output appears in the display.

5. Press the corresponding Channel Encoder **In** switch to assign the selected input or output. A lit Channel Encoder **In** switch indicates assignment.

6. To reassign, rotate the Channel Encoder until the desired input or output appears and press the Channel Encoder **In** switch.

7. To exit assign mode, press **Surface SHIFT + Flip/Channel**.

A track can be assigned to multiple outputs. See **Multiple Output Path Assignments**.
Using Channel Control

To route track input or track output using Channel Control:

1. Select a track. If several tracks are selected, make sure the track you want to adjust is attentioned.

2. Make sure the top-level Channel Control Knob Set is displayed. Press the Back Channel Control Navigation switch until it is displayed.

3. Do either of the following:
   - To assign track input, press the Channel Control Encoder under the display showing Input.
   - To assign track output, press the Channel Control Encoder under the display showing Mix.

A Channel Control display shows the current input or output assignment for the selected track.

4. Press the Channel Control Encoder under the display showing the current assignment. The leftmost Channel Control displays show the available types of input sources (interface, bus, or plug-ins) or output destinations (output or bus) for the selected track.

5. Rotate the Channel Control Encoder under the display until the desired input or output appears in the display.

6. Press the corresponding Channel Control Encoder In switch to assign the selected input or output. A lit Channel Encoder In switch indicates assignment.

7. To reassign, rotate the Channel Control Encoder until the desired input or output appears and press the Channel Encoder In switch.

8. To exit assign mode, press Surface SHIFT + Flip/Channel.

[To assign a track to multiple outputs, see Multiple Output Path Assignments.]
**Multiple Output Path Assignments**

You can assign a Pro Tools track to multiple output paths.

**To assign another track output:**

1. Repeat the previous instructions to assign a track output using the Channel Encoders or Channel Control.

2. Rotate the encoder to select the desired output type.

3. Press the corresponding Channel Encoder **Sel** switch to assign the selected output. The new assignment is *added* to the current assignments, and is indicated by a lit Channel Encoder **Sel** switch. When a track has multiple output assignments, a plus (+) sign appears next to the current track output assignment in the channel display (after exiting the Input Knob Set) and on-screen.

4. To clear all other assignments and assign the currently selected output, rotate the encoder to the desired output and press the encoder **In** switch.

---

**Banking Tracks**

Bank tracks to the channel strips using the **Bank, Nudge, Home, and End** switches. You can also bank tracks to channel strips using the Bank **A–F** switches by creating custom Layouts. p-o-[=

**To bank tracks to fader strips:**

1. Press the **Bank >** switch to bank the next set of 16 tracks. If tracks 1–16 were assigned to fader strips 1–16, tracks 17–24 are now assigned to the 16 fader strips.

2. Press the **Nudge >** switch to bank tracks one channel to right. If tracks 1–16 were assigned to fader strips 1–16, tracks 2–17 are now assigned to the 16 fader strips.

3. Press **Home** (*Surface SHIFT + < Bank*) to restore tracks 1–16 to the channel strips.

4. Press **End** (*SHIFT + Bank >*) to bank the last set of tracks to the channel strips.
Storing and Recalling Custom Layouts

Layouts let you assign specific tracks to specific channel strips on the S3, and have those channel strips ignore banking and nudging (ensuring that the specific tracks remain available for as long as the Layout is active). You can store Layouts using the Assign and Layouts tabs of the EuControl Settings application. Once stored, you can then recall Layouts using the Bank switches A–F. Bank switches A–F correspond to Layouts 1–6 respectively. Shift + A–F correspond to Layouts 7–12 respectively. Layouts are saved with your Pro Tools session.

Creating a Default Layout

Before creating a custom Layout, we recommend saving one default “home” Layout so you can quickly return fader strips to standard banking.

To create a “home” Layout and save it to Bank switch A:

1. Launch Pro Tools (or another application) and open your session.
2. Click the EuControl icon on the taskbar (Mac) or the System tray (Windows), and select EuControl Settings to open the EuControl Settings application.
3. Click the Assign tab and make sure Pro Tools (or your other targeted application) appears next to Application. The 16 S3 channel strips appear in the Strip column, and tracks assigned to each channel strip appear in the Assigned To column.

   You can also press Surface SHIFT + a channel Sel switch to automatically open the Assign tab of EuControl Settings.

4. Make sure all strips say <auto assigned> in the Assigned To column. If any are not, click the displayed name in the Assigned To column and choose <auto assigned>.

5. Click the Layouts tab, double-click the first layout in the list, type in a name, then press Enter.

6. Making sure row 1 is still highlighted, click Store. You can recall your “home” Layout by pressing Bank switch A.
Creating a Custom Layout

To create a custom Layout on Bank switch B:

1. Click the Layouts tab, double-click row 2, type in a name, and press Enter.
2. Be sure the Layout you have named is highlighted, then click the Assign tab.
3. Click in the Assigned To column and select a track from the pop-up to assign (lock) that track to the corresponding channel strip. Repeat for each available strip.
4. Return to the Layouts tab and click Store. The Layout is saved with your Pro Tools session.
5. On the S3, press Bank switch B to recall the first custom Layout.

Layouts and Banking/Nudging

Once you recall a Layout, banking or nudging only moves focus by the number of available (<auto assigned>) channel strips. For example, if a Layout includes three tracks assigned to strips 1–12, pressing Bank > only banks four strips at a time (since only four faders, 13–16, are <auto assigned> or “not locked” to a specific track). Note also that it is possible to end up with one track appearing on and being controllable by more than one strip. In this case, changes made to one strip are reflected in the other.

Layouts and VCA Spill

By default, if you spill a VCA while a Layout is recalled, the spilled VCA member tracks overwrite tracks from the Layout. Un-spilling the VCA returns fader strips to their previous assignments from the Layout.

You can defeat this default behavior in the Preferences tab of EuControl Settings. When the VCA Spill Overrides Layouts setting is disabled, member tracks of a spilled VCA can only spill to any <auto assigned> strips in the current Layout. If the current Layout has explicitly assigned to all 16 S3 fader strips, no member tracks will be visible.

For more information, see VCA Spill and Layouts.
Working with Track Groups

You can add and remove tracks to Pro Tools track Groups, and suspend or enable Groups using the Channel Encoders or Channel Control on S3. Groups must be created in Pro Tools before they can be accessed and modified on the S3.

Using the Channel Encoders

To add or remove tracks from a Group using the Channel Encoders:

1. Press **Surface SHIFT + Aux/Group**.

   ![Channel Encoder Diagram]

   The display shows `<All>` above each encoder (or the letter designation of the last edited group). All tracks are members of the `<All>` group by default.

2. Press the lit **Page >** Channel Encoder Navigation switch to show other available Groups across the display. As you navigate to other Groups, Channel Encoder **In** switches light to indicate track membership in the currently displayed Group.

3. To add a track to the currently displayed Group, press the Channel Encoder under the displayed Group name. The corresponding Channel Encoder **In** switch lights green showing that track is now a member of the currently displayed Group.

4. To remove a track from a Group, press the Channel Encoder again so that the Channel Encoder **In** switch is unlit.

To enable or suspend a track Group:

1. Press **Surface SHIFT + Aux/Group**. The display shows `<All>` in every fader display (or, the letter designation of the last edited group).

2. Press the lit **Page >** switches to show other available Groups across the display. As you navigate to other Groups, the Channel Encoder **Sel** switches (in the encoder row) light to indicate an active (enabled) Group.

3. To enable a Group, press any unlit Channel Encoder **Sel** switch so it is lit.

4. To suspend a Group, press any lit Channel Encoder **Sel** switch so it is unlit.
Using Channel Control

To work with track Groups using Channel Control:

1. Select a track, and make sure it is attentioned.

2. From the Channel Control top-level Knob Set, press the Channel Control Encoder under the display showing Groups. The Channel Control displays show the available Groups.

   *If the top-level Channel Control Knob Set is not shown, press the Back Channel Control Navigation switch until it is shown.*

3. To add the track to a Group, press the Channel Control Encoder under the display showing the desired Group so the corresponding Encoder In switch is lit.
   - To remove the track, press the Channel Control Encoder so the In switch is unlit.

4. To enable a Group, press any unlit Channel Control Encoder Sel switch so that it is lit.
   - To suspend a Group, press any lit Channel Encoder Sel switch.

5. To edit another track’s Group properties without returning to the top-level Channel Control Knob Set, just select the channel.

Working with VCAs

VCA Spill lets you quickly access (spill) only those channels assigned to the selected VCA Master track to the S3 channel strips. S3 provides two VCA Spill modes, Single-Master mode and Multi-Master mode.

![Diagram of S3 with Pro Tools interface]

- **Mix groups are assigned to VCA Master tracks in Pro Tools. See Pro Tools Help for instructions on creating VCA Masters.**

Spilling VCAs in Single-Master Mode

In Single-Master mode, spilling a VCA Master spills the VCA’s member tracks and the VCA Master track to the channel strips.

**To spill a VCA Master track in Single-Master mode:**

1. Bank a VCA Master to the channel strips.

2. Double-press the Sel switch on a VCA Master track.
   - VCA members 1–15 are spilled to channels 1-15 on the control surface, and channel LEDs light solid dark green.
   - The VCA Master is assigned to channel 16 on the control surface, and the corresponding channel LED lights solid dark green.
   - The VCA Master remains on that channel strip while VCA Spill is active.

   *If your system include a Pro Tools | Dock, the VCA Master can also be assigned to the Dock fader strip. See the Pro Tools Dock.pdf for more information.*

3. If the VCA has more than 15 members, do either of the followings:
   - Press Bank > or < Bank to access the next or previous bank of channels.
   - Press Nudge > or < Nudge to advance or return one track at a time.

4. To exit VCA Spill, double-press the Sel switch on VCA Master track (channel 16). The previous track assignments are restored to the channel strips.
   - or –
   - Press a switch, such as a Bank A–F switch, that is assigned to recall a custom Layout.
Spilling VCAs in Multi-Master Mode

In Multi-Master mode, 8 or 12 VCA member tracks can be spilled to the surface while 8 or 4 VCA Masters are assigned to their own “spill zone.” This lets you have access to multiple VCA Masters and a selected VCA’s member tracks simultaneously. Once spilled, members and masters can be banked within their zones independently.

EuControl provides a preference setting that lets you set the number of channel strips VCA member tracks are spilled to in Multi-Master mode.

To set the size of the Multi-Master mode VCA Spill Zone:

1. Click the EuControl icon on the taskbar (Mac) or the System tray (Windows), and select EuControl Settings to open the EuControl Settings application.

2. Click Preferences, and under Multi-Master Mode in the S3 VCA Spill section, select one of the following:

   - **Assign VCA Masters to Channel Strips 9–16**
     When selected, up to eight VCA Masters are assigned to S3 channel strips 9–16. Members of the selected VCA Master are spilled to channel strips 1–8 in banks of eight channels.

   - **Assign VCA Masters to Channel Strips 13–16**
     When selected, up to four VCA Masters are assigned to S3 channel strips 13–16 (you can nudge to bring VCA Masters 5–8, if present, to channel strips 13–16). Members of the selected VCA Master are spilled to channel strips 1–12 in banks of 12 channels.

To spill a VCA Master track in Multi-Master mode:

1. Press the < Bank and Bank > switches simultaneously.

2. To spill, double-press a VCA Master Sel switch.

3. To bank to the next or previous bank of the currently spilled VCA members, press Bank > or < Bank.

4. To access additional VCA Masters, press Nudge > or < Nudge.

5. To exit Multi-Master mode, press the < Bank and Bank > switches simultaneously. The previous track assignments are restored to the channel strips.

   - or –
     - Press a switch, such as a Bank A–F switch, that is assigned to recall a custom Layout.

Recalling the Last Spilled VCA

You can quickly recall the last spilled VCA without having to bank through channels to find it.

To recall the last spilled VCA:

1. Press < Nudge and Nudge > simultaneously.

2. To exit VCA Spill, press < Nudge and Nudge > simultaneously. The previous track assignments are restored to the channel strips.

   - or –
     - Double-press the Sel switch on the VCA Master track (channel 16).

VCA Spill and Layouts

By default, VCA Spill overrides Layouts. For more information, see VCA Spill Overrides Layout.
Working with Plug-Ins

You can assign plug-ins to tracks using Channel Control, and adjust them using the Channel Encoders or Channel Control.

Assigning Plug-Ins

Assign plug-ins to tracks using Channel Control and the Config switch.

To assign a plug-in to a track using Channel Control:

1. Select a track, and make sure it is attentioned.
2. From the Channel Control top-level Knob Set, press the Inserts Channel Control Encoder.

The Channel Control displays now show the available Inserts slots. If no plug-in is inserted in a slot, the slot letter appears in lower-case (a, b, c, and so on) in the corresponding display. If a plug-in is inserted in a slot, the name of the plug-in is shown in the corresponding display. Plug-in names are abbreviated as necessary.

3. Press the Config switch so it is lit. CFG appears in each Channel Control display.

4. Press the Channel Control Encoder under the display showing the Inserts slot you want to populate.
5. Press the Encoder under the display showing Plug-In.
6. Press the Encoder under the display showing the plug-in type you want to insert, such as EQ, Dynamics, or Reverb.
7. Press the Encoder under the display showing the desired plug-in to assign the plug-in.

Adjusting Plug-Ins

Plug-Ins can be accessed and adjusting using the Channel Encoders and Channel Control. You can also access only EQ plug-ins or only dynamics plug-ins. Plug-in parameter mapping to the Channel Encoders and the Channel Control Encoders depends on the selected Knob Set, as follows:

Inserts Knob Set In the Inserts Knob Set, parameters are mapped according to the manufacturer’s specifications. Parameter mapping can vary between plug-ins, even of the same type.

EQ and Dyn Knob Sets In the EQ and Dyn Knob Sets, parameter mappings are standardized across types of plug-ins. For example, the threshold controls for two compressor plug-ins from different manufacturers appear on the same encoder.
Adjusting Plug-Ins Using the Channel Encoders

To adjust plug-ins on the Channel Encoders using the Inserts Knob Set:

1. Press **Insert**. Plug-ins assigned to first Inserts slots (a) for the currently banked channels are shown in the channel displays. If no plug-in is inserted in that slot for the corresponding track, the Inserts slot letter is shown.

2. Press the Channel Encoder under the display showing the plug-in you want to access. Channel mode is enabled on the Channel Encoders, and the parameters for the selected plug-in on the attentioned track are spilled across the 16 Channel Encoders.

3. Do any of the following to adjust parameters:
   - Rotate the Channel Encoder below the desired parameter to adjust its value. To access Q (width) for an EQ band in EQ3, press the encoder **Sel** switch below the desired Frequency, then rotate the encoder. Press **Sel** again to return to Frequency.
   - Press the Channel Encoder **In** switch to toggle the corresponding parameter on/off, where applicable. For example, to switch an EQ3 band between filter types (such as Peak and Shelf) press the **In** switch next to the encoder for the desired band Frequency. To toggle an EQ band in/out, press the **In** switch next to the encoder for the desired band Gain.
   - Press the Channel Encoder **Sel** switch to toggle a secondary parameter on the Channel Encoder, where applicable. Additional parameters might be available with other plug-ins, so check with the manufacturer for more information.

4. Press the lit < Page > Channel Encoder Navigation switches to access more parameters.

5. Press the Back Channel Encoder Navigation switch to exit that plug-in and Channel mode.

6. Press the lit Page > Channel Encoder Navigation switch to access the next Inserts slots.

To adjust an EQ plug-in on the Channel Encoders using the EQ Knob Set:

1. Select a track, and make sure it is attentioned.

2. Press **EQ**. Channel mode is enabled on the Channel Encoders, and the parameters for the first EQ plug-in on the attentioned track are spilled across the 16 Channel Encoders.

3. Press **Pan** to exit the plug-in and Channel mode.

To adjust a Dynamics plug-in on the Channel Encoders using the Dyn Knob Set:

1. Select a track, and make sure it is attentioned.

2. Press **SHIFT + Inserts/Dyn**. Channel mode is enabled on the Channel Encoders, and the parameters for the first dynamics plug-in on the attentioned track are spilled across the 16 Channel Encoders.

3. Press **Pan** to exit the plug-in and Channel mode.
Adjusting Plug-Ins Using Channel Control

To adjust plug-ins in Channel Control using the Inserts Knob Set:

1. Select a track and make sure it is attentioned.
2. Press the Channel Control Encoder under the display showing Inserts. The Channel Control displays show the plug-ins that are inserted on the attentioned track. If no plug-in is inserted in that slot, the Inserts slot letter is shown.

3. Press the Channel Encoder under the display showing the plug-in you want to access. The parameters for that plug-in are spilled across the entire top row of 16 Channel Control Encoders.
4. Do any of the following to adjust parameters:
   - Rotate the Channel Control Encoder below the desired parameter to adjust its value.
   - Press the Channel Control Encoder In switch to toggle the corresponding parameter on/off, where applicable.
   - Press the Channel Control Encoder Sel switch to toggle a secondary parameter on the Channel Encoder, where applicable.
   - Press the In Channel Control Navigation switch to bypass the entire plug-in.
5. Press the lit < Page > Channel Control Encoder Navigation switches to access more parameters.
6. Press the Back Channel Control Encoder Navigation switch to exit that plug-in and return to the previous menu, or press SHIFT + Back/Top to return to the top-level Channel Control Knob Set.

To adjust an EQ plug-in using the Channel Control EQ Knob Set:

1. Press the Channel Control Encoder under the display showing EQ. The parameters for the first EQ plug-in are spilled across the entire top row of 16 Channel Control Encoders.
2. Press the lit < Page > Channel Control Encoder Navigation switches to access more parameters.
3. Press the Back Channel Control Encoder Navigation switch to exit that plug-in and return to the previous menu, or press SHIFT + Back/Top to return to the top-level Channel Control Knob Set.

To adjust a dynamics plug-in using the Channel Control Dyn Knob Set:

1. Press the Channel Control Encoder under the display showing Dyn. The parameters for the first dynamics plug-in are spilled across the entire top row of 16 Channel Control Encoders.
2. Press the lit < Page > Channel Control Encoder Navigation switches to access more parameters.
3. Press the Back Channel Control Encoder Navigation switch to exit that plug-in and return to the previous menu, or press SHIFT + Back/Top to return to the top-level Channel Control Knob Set.

To bypass all plug-ins on a track:

1. Select a track.
2. Press the Channel Control Encoder under the display showing Inserts.
3. Press the In Channel Control Navigation switch so it is unlit to bypass all the plug-ins for the selected track.
**Working with Sends**

This section shows how you can assign and adjust Pro Tools sends.

**Assigning Sends**

Use Channel Control to assign sends. You can assign a send to multiple tracks at once using the **Multi Assign** switch (Do to Selected and Do to All).

**To assign sends using Channel Control:**

1. Select one or more tracks.
2. From the Channel Control top-level Knob Set, press the **Sends** Channel Control Encoder.

The Channel Control displays now show available Sends slots a–j.

ısı If the top-level Channel Control Knob Set is not shown, press the Back Channel Control Navigation switch until it is shown.

3. Press **Config** so it is lit. CFG appears in the Channel Control displays.

4. Press a Channel Control Encoder under the display showing the send you want to assign. The leftmost Channel Control Encoders now display the available send types (output or bus).

5. Under the display showing the type of send you want to assign, rotate the Channel Control Encoder until the desired send appears in the display (such as Bus1-2).

6. To assign the same send to multiple selected tracks (Do to Selected), press **Multi Assign** so it is lit.

7. To assign the same send to all tracks in the session (Do to All), press and hold **Surface SHIFT + Multi Assign**.

8. Press the corresponding Channel Control Encoder **In** switch so it is lit to assign the send to the selected track(s).

9. Press **Config** so it is unlit to exit Config mode.
Adjusting Sends

You can access and adjust sends using the Channel Encoders or Channel Control.

To access a send using the Channel Encoders:
1. Bank to the desired track.
2. Press the Aux Channel Encoder Assign switch. Send assignments in slot a are displayed in the Channel Encoder displays for the currently banked channels.
3. To view other sends, press Page > until the desired sends are displayed (such as Bus 1–2).

To access sends using Channel Control:
1. Select a track.
2. From the top-level Channel Control Knob Set, press the Channel Control Encoder under the display showing Sends. The Channel Control displays show the send assignments for the send slots on that channel. If a send is not assigned in that slot for the selected track, the Sends slot letter is shown.

To adjust send level:
- Rotate the encoder under the display showing the send you want to adjust.

To mute the send:
- Press the encoder In switch under the display showing the send you want to mute. When muted, the In switch is unlit; when the send is on, the In switch is lit.

To mute all sends on a track:
- From the top-level Channel Control Knob Set, press the In switch under the displays showing Sends.
- or-
- With Sends spilled to the Channel Control Encoders, press the Channel Control Navigation In switch.

To toggle the send between pre- and post-fader:
- Press the encoder Sel switch under the display showing the send you want to adjust. When the send is post-fader, the Sel switch is unlit. When the send is pre-fader, the Sel switch is lit. Sends are post-fader by default.

To adjust send pan:
1. Press the encoder under the display showing the send you want to adjust. If the send is stereo, a single encoder will be mapped to send pan (usually encoder eight). If the send is three or more channels (such as LCR, or a 5.1 send), additional send pan parameters become available in the encoders (such as divergence, center percentage, and other multichannel pan parameters).
2. Rotate the appropriate encoder.
Muting/Unmuting Sends

You can mute/unmute individual sends using the Channel Encoders and Channel Control.

To mute/unmute a send:
1. Bank to the desired track.
2. Using the Channel Encoders, do the following:
   - Press Aux.
   - Use the < Page and Page > keys to navigate the displays until the desired send is shown.
3. Using Channel Control, do the following:
   - Select a track and make sure it is attentioned.
   - Press the Sends Channel Control encoder.
4. Hold the Command + Control Modifier switches and press the encoder Sel switch for the desired send.

Working with Automation

This section shows many of the ways you can control automation settings using the S3.

Selecting Track Automation Modes

You can select track Automation Modes using the channel strip REC/A (Auto) switches and the Function switches. The current Automation Mode is shown in the corresponding channel display on the S3, and on-screen.

💡 You can swap the primary and SHIFT functions of the Rec/A switch in the General tab of EuControl Settings.

Using the REC/A Switches

REC/A (Surface SHIFT + Rec) lets you cycle through the following automation modes:

To select the automation mode using the REC/A switches:
1. Hold Surface SHIFT + REC/A on a track.
2. Press Surface SHIFT + REC/A again to cycle through the following automation modes
   - blank = automation is off
   - r = read
   - w = write
   - rw = read/write
3. To change the automation mode on all tracks, hold Option (Mac) or Alt (Windows) while pressing SHIFT + REC/A.
4. To change the automation mode on all selected tracks, hold Option + Shift (Mac) or Alt + Shift (Windows) while pressing SHIFT+REC/A.
Using the Function Switches

The following table shows the available automation modes on the Function switches.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Automation Function</th>
<th>Switch</th>
<th>Automation Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Write</td>
<td>F2</td>
<td>Read</td>
</tr>
<tr>
<td>F3</td>
<td>Touch</td>
<td>F4</td>
<td>Automation Off</td>
</tr>
<tr>
<td>F5</td>
<td>Latch</td>
<td>F6</td>
<td>Automation Match</td>
</tr>
<tr>
<td>F7</td>
<td>Trim</td>
<td>F8</td>
<td>Automation Window</td>
</tr>
<tr>
<td>F9</td>
<td>Preview</td>
<td>F10</td>
<td>Write to All/Selected</td>
</tr>
<tr>
<td>F11</td>
<td>Punch Preview</td>
<td>F12</td>
<td>Write to Start</td>
</tr>
<tr>
<td>F13</td>
<td>Capture</td>
<td>F14</td>
<td>Write to End</td>
</tr>
<tr>
<td>F15</td>
<td>Punch Capture</td>
<td>F16</td>
<td>Write to Next</td>
</tr>
<tr>
<td>9–16</td>
<td>Toggles switches between banks F1-F8 and F9-F16</td>
<td>Show Me (Eye Icon)</td>
<td>Opens EuControl Settings &gt; Soft Keys &gt; Right Control section</td>
</tr>
</tbody>
</table>

To select the Automation Mode using the Function switches:
- Press and hold the Function switch for the desired Automation Mode, then select a channel.

To select the automation mode on multiple tracks using the Function switches:
1. Select multiple channels.
2. Press and hold Multi-Select/SHIFT+ ALT, then press the switch for the desired Automation Mode.

The Function Switch LED lights whenever its respective automation mode is enabled. In certain automation modes (such as Write) the LED flashes.

Shortcuts to Display Automation Playlists

The following shortcuts let you quickly display the breakpoint automation playlist for a control by clicking it in combination with modifier keys on your computer keyboard.

**Waveform View**

To show the waveform for a track in the Edit window:
- Hold Control + Command (Mac) or Control + Start (Windows) and press the channel Sel switch.

**Track Volume View**

To show volume automation for a track in the Edit window:
- Hold Command + Control (Mac) or Control + Start (Windows) and touch the track fader.

**Track Pan View**

To show track pan automation in the Edit window:
1. Press PAN to assign pan to the Channel Encoders.
2. Hold Control + Command (Mac) or Ctrl + Start (Windows) and touch the Pan encoder on a track.
Send Level View

To show Send level automation in the Edit window:

1. Press AUX to assign sends to the Channel Encoders.
2. If necessary, press the Page > Channel Encoder Navigation switch until the desired Sends slot is displayed.
3. Hold Control + Command (Mac) or Ctrl + Start (Windows) and touch the Send encoder in the desired track.

Send Pan View

To show Send pan automation in the Edit window:

1. Press AUX to assign sends to the Channel Encoders.
2. If necessary, press the Page > Channel Encoder Navigation switch until the desired Sends slot is displayed.
3. Press the encoder for the desired send.
4. Hold Control + Command (Mac) or Ctrl + Start (Windows) and touch the Send pan encoder on a track.

Plug-In Automation

Plug-In Parameters can be enabled for automation from the S3.

Pro Tools provides a preference setting for newly inserted plug-ins to default to all parameters enabled for automation. Go to Pro Tools > Preferences > Mixing, and under Automation, select Plug-In Controls Default to Auto-Enabled.

Enabling All Plug-in Parameters for Automation

To enable all plug-in controls for automation on Artist Mix:

1. Press INSERT.
2. If necessary, press the Page > Channel Encoder Navigation switch until the desired Inserts slot is displayed.
3. Hold Control + Command + Option (Mac) or Control + Start + Alt (Windows) and press the Channel Encoder In switch under the display showing the plug-in for which you want to enable automation.

Enabling an Individual Plug-In Parameter for Automation

To enable automation for a plug-in parameter:

1. Press INSERT.
2. If necessary, press the Page > Channel Encoder Navigation switch until the desired Inserts slot is displayed, and press the Channel Encoder under the display showing the plug-in you want to access.
3. If necessary, press the Page > Channel Encoder Navigation switch until the desired parameter is displayed.
4. Hold Control + Command + Option (Mac) or Control + Start + Alt (Windows) and do one of the following:
   - For a continuous plug-in parameter such as a level control, touch the encoder for the desired parameter.
   - For a switch-type parameter such as an In/Out switch, press the Channel Encoder In switch for the desired parameter.

Suspending the Faders

You can suspend the faders so they do not follow any underlying automation for quieter operation during editing or mixdown. This does not affect automation, it merely parks the faders so they do not move during playback. To access the Suspend Faders feature, use the Soft Key Editor to define a Soft Key for Faders Off (in the Global menu of EUCONS commands for Pro Tools).

Previously, Suspend Faders was available by holding surface Shift and pressing Solo on S3 fader strip 1. This was removed to prevent it from restricting other actions while Shift was latched on.
S3 Audio I/O Connections

This chapter shows how to use the built-in audio I/O on the S3, including:

- Enabling S3 Audio on the Workstation Computer
- Direct Out Mode
- S3 Audio Connections Overview
- Accessing Audio Control on the S3
- Connecting and Adjusting Inputs
- Connecting and Adjusting Outputs
- Connecting Hardware Inserts
- Connecting and Adjusting Headphones
- Saving S3 Monitor Settings

Enabling S3 Audio on the Workstation Computer

To use the audio I/O on your S3 with your workstation computer, you must first enable the audio connection on the workstation computer. This connection only needs to be enabled the first time you connect the S3 to a particular computer.

💡 At the time of this writing, using S3 as an AVB audio interface is only supported on Mac.

To enable S3 audio on your workstation computer:

1. Connect S3 to your workstation computer.
2. Power on S3, and make sure the S3 is in Studio mode (see Toggling Studio and Live Modes for more information).
3. Power on your workstation computer.
4. On your computer, go to Applications > Utilities > Audio MIDI Setup and from the Window menu, choose Show Network Device Browser.
5. Click the checkbox next to Avid S3. If more than one device appears and both are checked, deselect the other device. Once checked, the S3 appears in the list of available audio devices in the Audio Devices Window of the Audio MIDI Setup.
7. From the Playback Engine pop-up, choose Avid S3:AVB.
8. Choose Setup > IO Setup. Click Default on both the Input and Output tabs, then click OK to close IO Setup.

For other DAWs, see the documentation for the application to configure its I/O settings.
Direct Out Mode

S3 Audio Control provides Direct Out mode on a per input basis. This lets you use the S3 in the following ways:

**Standalone Mixer** You can send any S3 audio input to any S3 audio output, letting you use S3 as a 4-in/6-out mixer.

**Zero-Latency Monitoring** While recording through S3, use Direct Out mode to route S3 input(s) to your main monitor outputs. In Pro Tools, mute the track you are recording to. Use the S3 encoder for Direct Out Level as a mix knob to balance input level with your main mix. This is similar to the Mix Knob on Mbox and other similar audio interfaces.

Note: Low-Latency Monitoring in Pro Tool is not supported with S3.

**Talkback** Any input can be set to be the S3 Talkback input. Talkback can be engaged (momentary or latched) using the Mix to Mons switch, or the User switch and/or a footswitch. For more information, see Using Talkback.

Direct Out Mixer QuickStart

1. Make sure the S3 is in Studio mode (see Toggling Studio and Live Modes for more information).
2. Simultaneously press the right-side < Page and Page > Channel Control Navigation switches to access Audio Control.
3. Hold the Surface SHIFT switch then press the encoder for any Audio Control input. Direct Out controls for that input channel are shown in its encoder display.

4. To assign the input to an available S3 audio output, press the encoder Sel switch. Each press cycles the assignment to the next available output (such as All, Out 1–2, Out 1, Out 2, or None). Any stereo or mono output can be chosen.
5. Rotate the encoder to set the Direct Out level.
6. Press the encoder to mute the Direct Out signal.

Avoiding Double-Monitoring

If you do not plan on using Direct Out mode for zero-latency monitoring or for talkback, but are planning on using S3 Audio Control for DAW/AVB monitoring, do the following to ensure that no audio is routed twice to your monitoring outputs:

1. Make sure to assign None as the output for all S3 audio inputs.
2. Save the Audio Control settings (see Saving S3 Monitor Settings).
S3 Audio Connections Overview

S3 provides four channels of analog inputs to Pro Tools or other Core Audio-compatible applications that support sample rates of 48 kHz, and four channels of analog outputs for connecting monitors and other outboard audio devices.

1 – Inputs 1–2 (2 x XLR)
Inputs 1–2 are balanced microphone inputs, and are adjusted using the In 1 and In 2 Channel Control Encoders. Phantom power (48 Volts) and a 20 dB pad are provided on each input. Inputs 1–2 can be linked. See Connecting and Adjusting Inputs for more information.

2 – Inputs 3–4 (2 x 1/4-inch TRS)
Inputs 3–4 are line-level inputs that accept balanced TRS and unbalanced TS connections. Inputs 3–4 operate at a nominal level of +4 dBu, and are adjusted using the Line 3 and Line 4 Global Control Encoders. A 20 dB pad is provided on each input. Inputs 3–4 can be linked.

3 – Outputs 1–2 (2 x XLR)
MAIN
Outputs 1–2 are the main monitoring output pair for your audio/video application, and operate at a nominal level of +4 dBu. Controls for Outputs 1–2 are linked and are adjusted using the Main Channel Control Encoder. By default the monitor source for Outputs 1–2 are Out 1–2 from Pro Tools or other DAWs. Outputs 1–2 are active when Select is highlighted in the MAIN Channel Control Encoder display. See Connecting and Adjusting Outputs for more information.

$i$ The monitor source for the MAIN and ALT outputs can be changed using the Mon Prefs encoder. See Changing the Monitor Source for more information.

4 – Outputs 3–4 (2 x 1/4-inch TRS)
ALT
Outputs 3–4 are an alternate monitoring output pair and operate at a nominal level of +4 dBu. Outputs 3–4 accept balanced TRS and unbalanced TS connections. Outputs 3–4 are linked and are adjusted using the ALT Global Control Encoder. By default the monitor source for Outputs 1–2 are Out 1–2 from Pro Tools or other DAWs. Outputs 3–4 are active when Select is highlighted in the Alt Channel Control Encoder display. Track outputs can also be routed to Outputs 3–4 independently in Pro Tools.

5 – Headphone Output (1 x 1/4-inch Stereo TRS)
Headphone volume is adjusted using the volume wheel along the front edge of the S3. When the Mon to HP monitor preference is enabled, the headphone output mirrors Outputs 1–4 on the S3. Track outputs can also be routed to the Headphone output independently, and correspond to Out 5–6 in Pro Tools. See Connecting and Adjusting Headphones for more information.
Accessing Audio Control on the S3

Audio Control—the S3’s built-in I/O controls—are adjusted using Channel Control Encoders 9–16. Audio Control is hidden by default.

To access Audio Control:

- Simultaneously press the right-side < Page and Page > Channel Control Navigation switches.

![Right-side < Page > switches](image)

Controls for the built-in I/O are assigned to Channel Control Encoders 9–16.

![I/O controls in Channel Control](image)

Single Display Mode

Single Display mode lets Audio Control be focused on one single encoder (Channel Control encoder 16) instead of across eight encoders.

To enable Single Display Mode:

2. While in Single Display Mode, use the <Page and Page> switches to bank through each Audio Control page.

Connecting and Adjusting Inputs

You can adjust inputs using the Channel Control Encoders. You can also link Inputs 1–2 and 3–4 and control each pair using a single Encoder and associated switches.

To connect and route a mic or line input:

1. Connect a microphone to Inputs 1–2; connect a line-level device to Inputs 1–4.
2. In your audio/video application, assign S3 hardware inputs to the desired track(s). In Pro Tools, inputs on the S3 are called In 1–4 in the Input Path selector.

![Choosing an S3 Input in Pro Tools](image)
To adjust inputs:
1. If necessary, access Audio Control by simultaneously pressing the < Page and Page > Channel Control Navigation switches.
2. Do any of the following under the display showing the input you want to adjust:
   - To adjust input gain, rotate the encoder.
   - To engage the 20 dB pad, press the encoder Sel switch so its LED is lit green and Pad is highlighted in the display.
   - To engage 48v (phantom power) on Mic/Line Inputs 1–2, press the encoder In switch so its LED is lit red and 48v is highlighted in the corresponding display.

To link and unlink input pairs:
1. To link input pairs 1–2 or 3–4, press and hold Multi-Select/SHIFT, then press the Encoder under the display showing In 1 or In 2 to link 1–2, or In 3 or In 4 to link 3–4.
2. To unlink an input pair, press Multi-Select/SHIFT + the encoder under the display showing In 1-2 or In 3-4.

Using Talkback
Any input can be assigned as the Talkback input. Talkback can be engaged (momentary or latched) via the Mix to Mons switch, User switch and/or a footswitch.

To assign the Talkback input source:
1. Access Direct Out mode by holding SHIFT and pressing the encoder for the S3 input you want to assign as Talkback input.
2. Press the encoder In switch to assign that input as the Talkback input (Talkback becomes lit).

Example Talkback setup:
1. Connect your Talkback mic to S3 Input 1.
2. Hold surface SHIFT and press the encoder for S3 input 1, then in the Direct Out settings for Input 1, enable Talkback.
3. Press the encoder Sel switch to cycle through and assign Input 1 (talkback) to an S3 audio output.
4. If using a secondary audio interface such as an HD OMNI, you can connect the assigned S3 talkback output to an HD OMNI input. In Pro Tools, route that input to a desired Cue send output.
  💡 You could also route that HD OMNI input to an audio track and record it to use it as a Slate input.

To configure Talkback preferences:
1. Define how you want Talkback activated by rotating the encoder under TEngage= and choosing one of the following:
   - Mix to Mons
   - User (Engaging User for Talkback makes the User switch inaccessible to EuControl as a Soft Key)
   - Footswitch (Engaging footswitch for Talkback makes the footswitch inaccessible to EuControl for record/play operations)
   - User/Footswitch
To set polarity for footswitch Talkback engage:

1. Configure Talkback Engage for Footswitch or User/Footswitch.
2. Press the In switch below the TBEngage encoder to show polarity options.
3. Rotate the encoder to choose between normally open or normally closed to match your footswitch type.
4. Press Sel to save Talkback settings.

Connecting and Adjusting Outputs

You can toggle the monitor source between Outputs 1–2 (MAIN) and Outputs 3–4 (ALT), adjust the monitor level, and dim and mute (Cut) the outputs using the Channel Control Encoders. The default source for S3 Outputs 1–4 (and the Headphone output if MON to HP is selected) is Out 1–2. However, you can also assign tracks to S3 outputs independently.

You can also sum an output pair to mono and change the monitor source for the outputs.

To connect and route and outputs

1. Connect an audio destination such as audio monitors to Outputs 1–2 (Main) or Outputs 3–4 (Alt).
2. In your audio/video application, assign track outputs to the desired S3 hardware output(s). In the Pro Tools Output Path selector, Out 1–2 corresponds to S3 Outputs 1–2 (MAIN), Out 3-4 corresponds to S3 Outputs 3–4 (ALT), and Outs 5–6 correspond to the S3 Headphone output.

Choosing S3 Outputs in Pro Tools

To adjust outputs:

1. If necessary, access Audio Control by simultaneously pressing the < Page and Page > Channel Control Navigation switches.
2. To adjust an output pair, do any of the following under the display showing the output you want to adjust:
   - To make an output pair (Main or Alt) active, press the corresponding encoder Sel button so it is lit. Select is highlighted in the corresponding display, and the LED above the display is lit green for the currently selected output pair.
   - To toggle an output pair on/off, press the corresponding encoder In switch. The output pair is off (Cut) when the button is lit. Cut is highlighted in the corresponding display, and the LED above the display is flashes red.
   - To adjust the output level, rotate the encoder. The relative level in dB is indicated in the display.
   - To dim the output, press the encoder. Dim is shown in the display, and the LED above the display is lit orange.

To sum an output to mono:

1. Press and hold Multi-Select/SHIFT.
2. Press the Encoder for the output pair you want to sum to mono. Mono appears in the corresponding display. Mono signals are sent equally to each physical output in the pair.
3. Repeat to return to stereo operation.
### Changing the Monitor Source

You can change the monitor source for the outputs on the S3 using the Monitor Preferences (Mon Prefs) encoder.

**To change the monitor source:**

1. If necessary, access Audio Control.

2. Under the display showing Mon Prefs, press the encoder Sel switch to select an available monitor source as follows:

   **AVB 1–2** When AVB 1–2 is selected and appears in the display, Out 1-2 from Pro Tools and Core Audio are routed to Outputs 1–4 on the S3 (and the Headphone output if MON to HP is selected). This is the default monitor source setting for the S3.

   **In 1–2** When In 1–2 is selected and appears in the display, Inputs 1–2 on the S3 are routed to Outputs 1–4 on the S3 (and the Headphone output if MON to HP is selected). Use this to monitor an external source such as an audio interface or other playback device.

   **In 3–4** When In 3–4 is selected and appears in the display, Inputs 3–4 on the S3 are routed to Outputs 1–4 on the S3 (and the Headphone output if MON to HP is selected). Use this to monitor an external source such as an audio interface or other playback device.

**Mon Prefs encoder and display**

### Connecting Hardware Inserts

Inputs 3–4 and Outputs 3–4 can be used to insert external hardware on tracks in your application. When inserting hardware, be sure to connect the device to matching inputs and outputs on S3. For example, to insert a mono device, connect the input of the device to Output 3 on S3, then connect the output of the device to Input 3 on S3.

💡 In Pro Tools, inserts are defined in the IO Setup. Go to Setup > IO..., then click the Insert tab to define the session insert paths. See the Pro Tools Reference Guide for more information.

### Connecting and Adjusting Headphones

Use the front panel Headphone volume control to control overall Headphone volume. By default the stereo Headphone output mirrors the other outputs on the S3, but this can be disabled.

**To toggle Headphone output mirroring:**

1. If necessary, assign I/O controls to Channel Control.

2. Under the display showing Mon Prefs, press the corresponding encoder In switch. When Mon to HP is unlit, the Headphone output no longer mirrors Outputs 1–4.
Saving S3 Monitor Settings

You can save the current monitor settings on your S3, including monitor preference settings, and MAIN (Outputs 1–2) and ALT (Outputs 1–2) settings.

To save the current monitor settings:

1. Make any desired adjustments to the monitor settings on the S3.

   The 13th Channel Control display (TBEngage) displays Save. If you have engaged Single Display Mode, use the < Page and Page > switches to navigate the single Channel Control display (16) to TBEngage/Save.

2. Press the lit Encoder Sel switch.

   Saving Settings... appears in the display until saving is complete. Settings are saved until the next time you save.
**Soft Keys**

When using Pro Tools | S3 with Pro Tools and other selected DAWs, an Appset is installed providing default functionality for S3 surface controls. You can customize select switches on S3 using the Soft Key Editor provided in EuControl software.

### Overview

You can customize the functions of the switches in the following sections on the S3:

1. **Left Control**
2. **Right Control**
3. **View and Arrow Switches**
4. **Touchstrip**

*Image: S3 top panel*
Viewing Soft Key Assignments in the Soft Key Editor

To view assignments in the Soft Key Editor:

1. Launch Pro Tools and confirm that EuControl is connected to the S3, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).

2. On S3, press the Show Me switch. The Soft Keys currently assigned to the Right Control switches are shown on-screen.

3. To view the second page of switches for the Right Control section, click the Page selector and choose Page 2 from the pop-up menu.

4. To view assignments for the other sections of switches, click the Section selector and choose one of the following:
   - Left Control
   - Views/Arrows
   - Touchstrip

   *Other options such as Surface and Touchscreen are not applicable to S3.*

5. To view switches assigned to the Shift layer (functions accessed by pressing the Surface SHIFT switch plus the relevant switch) of the Left Control, Views/Arrow, or Touchstrip sections, click to enable the Shift checkbox.
Using the Soft Key Editor

The Soft Key Editor lets you reassign a switch from its default Soft Key assignment (if applicable), add a new command to an unassigned switch, revert (undo) all recent assignment, and restore to factory default assignments. You can also add a key command to a switch to invoke a keyboard shortcut.

To reassign a Soft Key for Pro Tools:

1. Launch Pro Tools and confirm that EuControl is connected to the S3, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).
2. Press the Show Me switch.
3. Click the Section selector and choose the section of switches containing the switch you want to reassign.
4. On-screen double-click the switch you want to reassign. The Soft Key Command Editor window opens, showing the switch’s current assignment.

5. To reassign the currently selected switch, click a different command. For example, click Off in the third (right-most) list in the Details area. You can also click to make a new selection in the first (left-most) or middle Details list (such as File Menu, Edit Menu, and so on) to access other choices, as available.

6. Close the Soft Key Command Editor and return to the EuControl Settings window.
7. If desired, click the Save button in the Soft Keys tab to save the assignments. The next time you launch EuControl, your custom assignments are recalled.

💡 If you do not save assignments, EuControl software retains your assignments until you Quit (Mac) or Exit (Windows) the EuControl application. EuControl then recalls the default Appset the next time you launch EuControl.
To add a new assignment:

1. Launch Pro Tools and confirm the EuControl is connected to the S3, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).
2. Press the Show Me switch.
3. Click the Section selector and choose the section of switches containing the switch you want to assign.
4. On-screen, double-click the switch you want to assign. The Soft Key Command Editor window opens.
5. In the Command area, click Add and choose EUCON.

![Soft Key Command Editor window](image)

**Adding a new EUCON command**

After you add a EUCON command, choices appear in the Details area.

![Details area showing commands](image)

**The Details area showing commands**

6. Click an item in the left-most list (level 1) within the Details area to reveal associated commands in the middle column.

![An item selected in Level 1](image)

**An item selected in Level 1 (the first column) of the Details area**

7. Click a command to assign a command, or click an item with an arrow to reveal more commands in the third column and assign as necessary.
8. Close the Soft Key Command Editor and return to the EuControl Settings window.
9. If desired, click the Save button in the Soft Keys tab to save the assignments.
To revert (undo) all assignments since the last time you saved changes:

- Click the Revert button in the Soft Keys tab.

To restore assignments to their factory defaults:

- Click the Restore button in the Soft Keys tab.

**Adding a Custom Key Command**

You can invoke a keyboard shortcut that has no predefined function in the EuControl using the Soft Key Editor. The following workflow shows how to assign the Pro Tools shortcut for halving the length of an Edit selection (Command + Control + Option + Shift + L on Mac, and Ctrl + Alt + Start + Shift + L on Windows) to a switch on the S3.

💡 You can use the Pro Tools Shortcut Guide to find the relevant Pro Tools shortcuts for your operating system.

**To assign a custom key command:**

1. Launch Pro Tools and confirm EuControl is connected to the S3, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).
2. Press the Show Me switch on S3.
3. Click the Section selector and choose the section of switches containing the switch you want to assign.
4. On-screen, double-click the switch you want to assign. The Soft Key Command Editor window opens.
5. In the Soft Key Editor, do the following:
   - If the switch already has an assignment, select the assignment in the Command list then press Delete.
   - Click Add and choose Key.
6. In the Details area, select Control, Shift, Alt/Opt, and Win/Cmd, then enter “L” in the field below.
7. Close the Soft Key Command Editor and return to the EuControl Settings window. Now, pressing the assigned switch halves the length of the current Edit selection in the Pro Tools Edit window.
8. If desired, do any of the following:
   - Click in the Soft Key Label field and enter a name for the Soft Key assignment.
   - Click the Save button in the Soft Keys tab to save the assignment.
EuControl Software

EuControl is launched automatically upon starting your computer and runs in the background. EuControl is responsible for finding, linking, and communicating with all Avid media controllers on the network.

Accessing EuControl Settings

To open the EuControl Settings window, do one of the following:

• On Mac, click the EuControl icon on the taskbar and select EuControl Settings.
• On Windows, double-click the EuControl icon in the system tray and select EuControl Settings. If you don’t see the EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons, then double-click the EuControl icon.

Only one instance of EuControl can run on a workstation. However, multiple workstations on a single network can each run EuControl. Each EuControl-equipped workstation can connect one S3 on the network.

In this chapter, the tabs in the EuControl software are discussed in the order (left to right) as they appear at the top of the EuControl Settings dialog.

Surfaces

The Surfaces tab shows all EUCON controllers on your network and those connected to your instance of EuControl.

All Surfaces

All Surfaces shows all Avid media controllers on the network. A device shown in light gray is already connected either to your own or another instance of EuControl running on a different workstation. In both cases, it is not selectable.
My Surfaces

My Surfaces shows the media controllers connected to your instance of EuControl.

The top-to-bottom order corresponds to the left-to-right order of the surfaces, respectively. The leftmost surface is assigned to fader strip 1. Use the + and – buttons to reorder the list.

Each media controller can be renamed by double-clicking the existing name and typing a new name.

⚠️ *If you changed the name of the S3 in VENUE software, that name will appear in the My Surfaces list. Likewise, if you changed the name in the My Surfaces list, it will appear as such in VENUE software.*

Add

Click Add to add the selected All Surfaces entry to My Surfaces. This connects the selected Avid media controller to your instance of EuControl. You can also click and drag an Avid media controller from All Surfaces to My Surfaces.

Add is disabled if all media controllers in All Surfaces are connected to any instance of EuControl.

⚠️ *One S3 and one Artist Transport can be added to My Surfaces and used simultaneously with Pro Tools or other EUCON-enabled DAWs.*

Remove

Click Remove to remove the selected surface from My Surfaces and make it available to other instances of EuControl. Remove is disabled if no surface is selected.

Automatically Add

The Automatically Add menu has two settings that control what happens to stored Surfaces between shutdown and startup.

All Surfaces (Default)

This setting is best used when you are the only person running EuControl in your home or studio. It provides an easy plug-and-play experience by automatically adding your All Surfaces list to your My Surfaces list so you never have to manually edit the My Surfaces list.

My Surfaces Only

This setting is useful in facilities where other EuControl users are on your network. When EuControl starts, only the surfaces from your My Surfaces list are added. Because a surface can only be claimed by one user at a time, this avoids claiming another user’s surfaces.

Update Firmware

Each time a new version of EuControl is installed, it checks each media controller in your system to determine if any firmware updates are required. The firmware is embedded in EuControl so an Internet connection is not required.

Select each media controller in the My Surfaces list. Click Update Firmware to update their firmware. If a dialog displays a message that the firmware is up to date, no further action is necessary.

Follow the instructions in the EuControl dialog box.
- The media controllers must be plugged into a working power source.
- Do not power off any media controllers during the update or attempt to interrupt the update.
- The status for each media controller being updated is displayed on that device as well as in the EuControl dialog.

Show Info

Select a media controller and click Show Info to display the name of the unit, and hardware and software information.

EuControl Software 61
Workstations

A media controller can control applications running on a second computer, referred to in this guide as a workstation. The Workstations tab establishes the list of workstations that the Workstation switch cycles through. Any workstation running EuControl software can be in this list.

**Enable External Workstations**

Enables communication with other workstations (other than the one currently running EuControl). Before enabling an additional workstation, make sure you have installed EuControl or EUCON Workstation software on your secondary workstation and configured your systems as explained in [Connecting a Second Workstation](#).

When the Enable External Workstation setting is enabled, the Workstation tab also provides the **Redirect Keyboard and Mouse Control to Attached External Workstation** setting.

**All Workstations**

All Workstations lists all EUCON-enabled workstations on the network. If the workstation is already in the My Workstations list, it is shown in gray and cannot be selected.

**My Workstations**

My Workstations lists the workstations that can be attached to by pressing the Workstation switch (Surface SHIFT + Application/Workstation).

It is possible to put a workstation in the My Workstations list that is already attached to another instance of EuControl running on another computer. It cannot be attached here until it is unattached from the other instance of EuControl. This allows multiple users to share workstations without having to frequently edit their My Workstation list.

**Add**

Click Add to add the selected workstation from the All Workstations list to the My Workstations list. If the workstation is already in the My Workstations list, it is grayed out and cannot be selected.
Remove

Click **Remove** to remove the selected workstation from the My Workstations list.

Attach/Detach

Select a workstation in the My Workstations list and click **Attach**. A check mark appears in the Attach column next to that workstation. This workstation is now communicating with the media controller(s) connected to your instance of EuControl.

If the selected workstation is already attached, the button displays **Detach**. Click it to detach the workstation.

Redirect Keyboard and Mouse Control to Attached External Workstation

Your computer keyboard and mouse can control a second external workstation, if desired. Select this option to redirect keyboard and mouse control to the attached workstation. Note that the keyboard and mouse will no longer control your primary computer.

You can manually toggle control back and forth between your primary workstation and the attached external workstation by pressing Control+Option+Command+Esc (Mac), or Control+Alt+Win+Esc (Windows), or by pressing the **App/Workstation** switch on the Dock, S3, or other supported controller.

The Redirect Keyboard and Mouse Control to Attached External Workstation option must be checked **before** adding the workstation to the My Workstations list. If it is toggled ON after adding the workstation it will have no affect. Only workstations added with the option checked will respond.
**General**

The General tab lets you control how the S3 and application software work together.

---

**Workstation Tracks Knob Set Changes**

This command lets supported workstations follow selection of knob sets on S3.

**Open Plug-ins on Workstation When Editing**

This command lets supported workstations open plug-in windows on-screen when a plug-in is selected for editing on S3.

**Close Plug-ins on Workstation When Exiting**

This command lets supported workstations close plug-in windows on-screen when you press BACK or exit Inserts mode on an S3.

**Select by Touch**

This command lets supported workstations attention (focus) tracks on-screen when their fader is touched on the S3.

**Auto-bank to Selected Track**

When this is selected, S3 banks to tracks when the tracks are selected on-screen. The surface will auto-bank such that the selected track appears on the leftmost fader of the surface as long as the selected track is not currently visible on the surface.

**Display Track Numbers on Surface**

When this is selected, S3 shows track numbers as assigned by the current workstation (if supported) in the channel displays.

**Rec/Auto Switch Press**

The Rec/Auto switch press changes automation modes setting toggles the default function of the Rec/A switch (on S3 and Dock) and the Rec/Auto switch (Artist Mix and Artist Control).

- When enabled, pressing the Rec/Auto switch changes the track automation mode. SHIFT+Rec/Auto enables track record.
- When disabled, the Rec/Auto switch operates in its default configuration.
Dock Automation Mode Buttons Follow Attentioned Channel
(Pro Tools | Dock Only)

This setting lets you optimize how the Automation mode switches in the Left Control section select and indicate Automation modes. By default, this setting is off (not enabled).

- When not enabled (its default setting), you can set track Automation mode for the currently attentioned track by holding one of the dedicated Automation mode switches on the Dock, then pressing the Sel switch to the left of the Dock fader. The Automation mode switch LEDs light to indicate all automation modes currently enabled on any tracks in the session. When applying an automation mode change to a selection of tracks or all tracks, simply press the Do to Sel (Selected) or Do to All switches, then press the desired Automation mode switch. There is no need to press the Sel switch.
- When enabled, you can set track Automation mode for the currently attentioned track directly using the mode switches in the Left Control section (you do not need to hold an Automation mode switch and press Sel). The Automation mode switch LEDs light to indicate automation status only of the currently attentioned track.

At the time of this writing, this feature is fully supported only in Pro Tools. See the EuControl Read Me for more information.

Solo Mode

These settings let you configure the following Solo modes as (if) available in the current workstation:

- Solo-in-Place
- After-Fader Listen (AFL)
- Pre-Fader Listen (PFL)

See the documentation for your specific workstation for details on Solo modes.

Wheel Sensitivity
(Pro Tools | Dock, Artist Control, and Artist Transport Only)

The sensitivity of the Jog Wheel and Shuttle Ring can be precisely adjusted using the Wheel Sensitivity sliders. The top two sliders pertain to the Pro Tools | Dock and Artist Transport, the bottom is the Jog Wheel for the Artist Control.

The center position is the default for each control. Click and drag a slider to move it right for faster response or left for a slower, more controlled movement. Click the Reset button to restore the center position.

The name of the currently focused application is shown above the sliders (the application that will be affected by adjusting Wheel Sensitivity). If the controls have been locked to a specific application, the display will list it and identify it as the application being adjusted. For more information on locking, see Lock to Application.

Global or Application Specific

Click to enable the Global option to maintain a single set of your Wheel Sensitivity settings to be available regardless of the current application.

Click to enable the Application Specific option to be able to have unique Wheel Sensitivity settings in each application you use. To store settings, switch to your other application, open EuControl Settings > General, and adjust the Wheel Sensitivity sliders for that environment.
Preferences

**Artist Mix, Artist Transport, and Artist Control display dim time**

This setting lets you set the amount of idle time before displays on the supported units are dimmed.

**Footswitch**

*(Pro Tools | Dock, Pro Tools | S3, Artist Mix and Artist Control Only)*

You can connect a footswitch for hands-free punch in/out. Connect a footswitch to the 1/4-inch footswitch input on the back panel.

**To configure the Footswitch in EuControl:**

- In the Footswitch section of the Preferences tab, click to select the desired Punch In and Punch Out assignments:

  **Record | Record**

  When the application is rolling, pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again takes the track(s) out of record but does not stop the transport.

  **Record | Play**

  Pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again stops the record pass (your DAW may or may not automatically take the track out of record on stop; see the documentation for your application).

  **Status**

  Shows whether the footswitch state is currently on or off.

  *The S3 also lets you assign its footswitch to engage Talkback. For more information, see Using Talkback.*
S3 VCA Spill
(Pro Tools | S3 Only)

**Single-Master Mode (S3 + Dock)**

These settings let you specify where VCA Masters appear when spilled on systems that include an S3 and a Dock:

**Assign VCA Master to Dock**  Spilling a VCA Master assigns the spilled master to the fader strip on Pro Tools | Dock.

**Assign VCA Master to S3**  Spilling a VCA Master assigns the spilled master only to S3, not to the Dock.

**Multi-Master Mode**

These options determine VCA Spill behavior in Multi-Master Mode, as follows:

**Assign VCA Masters to Channel Strips 9–16**  When selected, up to eight VCA Masters are assigned to S3 channel strips 9–16. Members of the selected VCA Master are spilled to channel strips 1–8 in banks of eight channels.

**Assign VCA Masters to Channel Strips 13–16**  When selected, up to four VCA Masters are assigned to S3 channel strips 13–16. Members of the selected VCA Master are spilled to channel strips 1–12 in banks of 12 channels.

**VCA Spill Overrides Layout**

By default, if you spill a VCA while a Layout is recalled, the spilled VCA member tracks replace all tracks from the Layout. Un-spilling the VCA returns fader strips to their previous assignments from the Layout.

You can defeat this behavior in the Preferences tab of EuControl Settings. When the **VCA Spill Overrides Layout** setting is disabled, member tracks of a spilled VCA only spill to any <auto assigned> strips in the current Layout. If the current Layout has explicitly assigned tracks to all 16 S3 fader strips, no member tracks will be visible.

**Surface Brightness Control**

The settings in this section let you control brightness for Artist Control LCD screens and for the Pro Tools | Dock switch LEDs.

**Artist Control LCD Screen:**

Adjusts the brightness of the LCD screen on Artist Control (only). To increase brightness, adjust the slider to the right. To decrease, adjust to the left.

**Pro Tools | Dock:**

Adjusts the brightness of the switch LEDs on Pro Tools | Dock (only). To increase brightness, adjust the slider to the right. To decrease, adjust to the left. Setting the slider to the far left turns all switch LEDs off.

**Miscellaneous**

**Shift + Fader Sets Level to 0dB**

When enabled, holding **SHIFT** and touching a fader sets the fader to 0dB. **Surface SHIFT**-lock does not apply (**Surface SHIFT** must be pressed).
Assign

The Assign tab manages how tracks are assigned to S3 channel strips. By default, tracks are automatically assigned in banks of 16.

**Display Application’s Track Numbers**

Enabling this option lets EuControl display track numbers as assigned by the currently selected (in focus) application (if that application supports track numbers).

**Clear All Assignments**

Clears all currently displayed assignments.

**Lock to Application**

This feature does not apply to S3.

On supported media controllers, this feature lets the transport and monitor controls, and/or the entire surface, stay locked to the application listed at the top-left of the dialog, even when that application is not focused. The locked-to application also is the only application that will be affected by adjusting the EuControl Wheel Sensitivity settings.

**Entire Surface** Select this checkbox to lock the entire surface, including those of all linked Artist media controllers, to the listed application.

**Transport** Select this checkbox to lock the transport controls of Artist Transport and Artist Control to the listed application. All transport controls, including jog/shuttle wheels, are locked when selected.

**Monitor and Control Room** Locks the Monitor and Control Room controls to the listed application.
**Layouts**

Use the **Layouts** tab to store and recall custom fader layouts. For example, you can use the **Assign** tab to assign tracks to specific S3 channel strips. You can then save those assignments as part of a fader layout on the **Layouts** tab, which you can then recall using the Bank A–F switches. See **Storing and Recalling Custom Layouts**.

![Layouts tab](image)

Layouts are created and temporarily stored in EuControl as long as the current session or project is open. To be able to recall your layouts, be sure to save your session or project in your workstation application.

---

**Soft Keys**

This tab controls assignments and programming for the switches in the Left Control, Right Control, Views/Arrows, and Touchstrip sections. See **Soft Keys** for more information.

---

**Restart EUCON Applications**

If you are having trouble connecting your surface to your DAW, use the Restart EUCON Applications command.

To restart all EUCON applications (including EuControl software):

- On Mac, click the EuControl icon on the taskbar and select Restart EUCON Applications, then click Yes.
- On Windows, click the EuControl icon in the Task or System tray (Windows) and select Restart EUCON Applications, then click Yes. Unused icons will be shown in the Hidden icons view.

All EUCON applications are restarted, including EuControl.
Specifications

All specifications subject to change.

S3 Control Surface Audio Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Conditions</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Min.</td>
<td>Typ.</td>
</tr>
<tr>
<td>Phantom Power</td>
<td></td>
<td>48</td>
<td></td>
</tr>
<tr>
<td>Input Sensitivity</td>
<td>@ 997 Hz, Gain = 10 dB (min.)</td>
<td>48</td>
<td>+7.979</td>
</tr>
<tr>
<td>Equivalent Input Noise (EIN)</td>
<td>Gain = 60 dB, 150 Ω source impedance</td>
<td>-126.1</td>
<td>-126.1</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>V_{INPUT} = -12.035 dBu, 20 Hz – 20 kHz relative to 1 kHz, Gain = 10 dB (min.)</td>
<td>-0.021</td>
<td>0</td>
</tr>
<tr>
<td>Dynamic Range Unweighted</td>
<td>150 Ω source impedance, Gain = 10 dB (min.)</td>
<td>-111.2</td>
<td>-111.2</td>
</tr>
<tr>
<td>Dynamic Range A weighted</td>
<td>150 Ω source impedance, Gain = 10 dB (min.)</td>
<td>-113.8</td>
<td>-113.8</td>
</tr>
<tr>
<td>THD+N Amp</td>
<td>@ 997Hz, Gain = 40 dB</td>
<td>0.0007</td>
<td>0.0014</td>
</tr>
<tr>
<td>THD+N Freq</td>
<td>measured at -25.242 dBu, 20 Hz – 20 kHz, Gain = 40 dB</td>
<td>0.0007</td>
<td>0.0014</td>
</tr>
<tr>
<td>Common Mode Rejection Ratio</td>
<td>V_{INPUT} = -21.560 dBu, 20 Hz – 20 kHz, Gain = 10 dB (min.)</td>
<td>-71.7</td>
<td>-80.8</td>
</tr>
<tr>
<td>Inter-channel Crosstalk</td>
<td>V_{INPUT} = -12.150 dBu, 20 Hz – 20 kHz, Gain = 10 dB (min)</td>
<td>-120.4</td>
<td>-109.6</td>
</tr>
<tr>
<td>Input Impedance</td>
<td>@1 kHz</td>
<td>3.5K</td>
<td></td>
</tr>
</tbody>
</table>
### S3 Analog Mic Inputs, Pad Enabled

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Conditions</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phantom Power</td>
<td></td>
<td>48</td>
<td>Volts</td>
</tr>
<tr>
<td>Input Sensitivity</td>
<td>@ 997Hz, Gain = 10 dB (min.)</td>
<td>+28.322 dB</td>
<td>dBu</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>$V_{\text{INPUT}} = +8.225 \text{ dBu, 20 Hz – 20 kHz relative to 1 kHz, Gain = 10 dB (min.)}$</td>
<td>-0.016 0 -0.235 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Dynamic Range Unweighted</td>
<td>150 $\Omega$ source impedance, Gain = 10 dB (min.)</td>
<td>-111.2 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Dynamic Range A weighted</td>
<td>150 $\Omega$ source impedance, Gain = 10 dB (min.)</td>
<td>-113.9 dB</td>
<td>dB</td>
</tr>
<tr>
<td>THD+N Amp</td>
<td>@ 997 Hz, Gain = 40 dB</td>
<td>0.0018 %</td>
<td>%</td>
</tr>
<tr>
<td>THD+N Freq</td>
<td>measured at -3.808 dBu, 20 Hz – 20 kHz, Gain = 40 dB</td>
<td>0.0012 0.0018 0.0064 %</td>
<td>%</td>
</tr>
<tr>
<td>Common Mode Rejection Ratio</td>
<td>$V_{\text{INPUT}} = -1.276 \text{ dBu, 20 Hz – 20 kHz, Gain = 20 dB}$</td>
<td>-59.3 -63.8 -63.9 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Inter-Channel Crosstalk</td>
<td>$V_{\text{INPUT}} = +8.233 \text{ dBu, 20 Hz – 20 kHz, Gain = 10 dB (min.)}$</td>
<td>-122.1 -109.1 -98.2 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Input Impedance</td>
<td>@ 1 kHz</td>
<td>3.7 k</td>
<td>ohms</td>
</tr>
</tbody>
</table>

### S3 Analog Line Inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Conditions</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Sensitivity</td>
<td>@ 997Hz, Gain = 10 dB (min.)</td>
<td>+18.471 dB</td>
<td>dBu</td>
</tr>
<tr>
<td>Equivalent Input Noise (EIN)</td>
<td>Gain = 18 dB, 150 $\Omega$ source impedance</td>
<td>-93.9 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>$V_{\text{INPUT}} = -1.520 \text{ dBu, 20 Hz – 20 kHz relative to 1 kHz, Gain = 10 dB (min.)}$</td>
<td>-0.018 0 -0.233 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Dynamic Range Unweighted</td>
<td>150 $\Omega$ source impedance, Gain = 10 dB (min.)</td>
<td>-110.4 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Dynamic Range A weighted</td>
<td>150 $\Omega$ source impedance, Gain = 10 dB (min.)</td>
<td>-113 dB</td>
<td>dB</td>
</tr>
<tr>
<td>THD+N Amp</td>
<td>@ 997 Hz, Gain = 40 dB</td>
<td>0.0010 %</td>
<td>%</td>
</tr>
<tr>
<td>THD+N Freq</td>
<td>measured at +12.193 dBu, 20 Hz – 20 kHz, Gain = 40 dB</td>
<td>0.0005 0.0010 0.0016 %</td>
<td>%</td>
</tr>
<tr>
<td>Common Mode Rejection Ratio</td>
<td>$V_{\text{INPUT}} = -1.523 \text{ dBu, 20 Hz – 20 kHz, Gain = 0 dB}$</td>
<td>-64.4 -66.8 -67.0 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Inter-Channel Crosstalk</td>
<td>$V_{\text{INPUT}} = -1.520 \text{ dBu, 20 Hz – 20 kHz, Gain = 0 dB (min.)}$</td>
<td>-117.8 -110.1 -98.3 dB</td>
<td>dB</td>
</tr>
<tr>
<td>Input Impedance</td>
<td>@ 1 kHz</td>
<td>5.1 k</td>
<td>ohms</td>
</tr>
</tbody>
</table>
S3 Analog Outputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Conditions</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Sensitivity</td>
<td>@ 997 Hz</td>
<td>+24.201 dBu</td>
<td>dBu</td>
</tr>
<tr>
<td>Output Impedance</td>
<td>@1 kHz</td>
<td>103.5 ohms</td>
<td>ohms</td>
</tr>
<tr>
<td>Residual Output Noise</td>
<td>20 Hz – 20 kHz</td>
<td>-88 dBu</td>
<td>dBu</td>
</tr>
<tr>
<td>Round Trip Latency</td>
<td>Console input to Console output</td>
<td>3.2 ms</td>
<td>ms</td>
</tr>
</tbody>
</table>

S3 Headphone Output

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Conditions</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Impedance</td>
<td>@1 kHz</td>
<td>I</td>
<td>ohms</td>
</tr>
<tr>
<td>Output Sensitivity</td>
<td>32 Ω load @ 997 Hz, max output</td>
<td>+17.932 dBV</td>
<td>dBV</td>
</tr>
<tr>
<td>Max RMS Power Output</td>
<td>+20.157 dBu 32 ohm headphones</td>
<td>1.940 mW</td>
<td>mW</td>
</tr>
<tr>
<td></td>
<td>+19 dBu 600 ohm headphones</td>
<td>163.1 mW</td>
<td>mW</td>
</tr>
</tbody>
</table>

S3 Control Surface Mechanical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height (front)</td>
<td>1.3 inches (32.0 mm)</td>
</tr>
<tr>
<td>Height (back)</td>
<td>2.8 inches (71.7 mm)</td>
</tr>
<tr>
<td>Maximum Width</td>
<td>28 inches (711.11 mm)</td>
</tr>
<tr>
<td>Maximum Depth</td>
<td>14.3 inches (363.11 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>13.8 lbs (6.2 kg)</td>
</tr>
<tr>
<td>Power Requirements</td>
<td>100–240 V, 50–60 Hz, 200 W</td>
</tr>
<tr>
<td>Power Connectors</td>
<td>External PSU AC Input: IEC, 3-pin North American standard</td>
</tr>
<tr>
<td></td>
<td>External PSU DC Output: Kycon KPPX–4P; 12V, 7.5A max current</td>
</tr>
<tr>
<td>Audio Connectors (x8)</td>
<td>XLR3–M balanced (x2), XLR3–F balanced (x2), 1/4-inch TRS balanced (x4)</td>
</tr>
<tr>
<td>Headphone Connector</td>
<td>1/4-inch TRS unbalanced</td>
</tr>
<tr>
<td>Network Connectors (x2)</td>
<td>RJ-45 Neutrik etherCON</td>
</tr>
<tr>
<td>USB Ports (x2)</td>
<td>USB 2.0 (for connecting mouse and keyboard only)</td>
</tr>
<tr>
<td>Footswitch Connector</td>
<td>1/4-inch TRS</td>
</tr>
<tr>
<td>Light Connectors (x2)</td>
<td>XLR3–F; LED console light required</td>
</tr>
</tbody>
</table>
Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Proposition 65 Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply. See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

EMC (Electromagnetic Compliance)

This model Pro Tools | S3 complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55022 Class B
• EN 55024 Class B
• AS/NZS CISPR 22 Class B
• CISPR 22 Class B
FCC Compliance for United States

Radio and Television Interference

Communication Statement
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, could void the user's authority to operate the equipment.

Australian Compliance

Canadian Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance
(EMC, Safety, and ROHS)

Avid is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC, Low Voltage Directive 2006/95/EC and RoHS Directive 2011/65/EC.

Korean EMC Compliance
이 기기는 가정용 (B 급) 전자파적합기기로서 주로 가정에서 사용하는 것을 목적으로 하며, 모든 지역에서 사용할 수 있습니다.
Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certifications in accordance with the specifications of UL Standards: UL60950-1:2007, 2nd Edition and canadian CAN/CSA C22.2 60950-1-07, 2nd Edition. Avid Inc. has been authorized to apply the appropriate UL and CUL mark on its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this equipment near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.
11) Only use attachments/accessories specified by the manufacturer.
12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.
13) Unplug this equipment during lightning storms or when unused for long periods of time.
14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.
15) For products that are a Mains powered device:
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.
16) For products containing a lithium battery:
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.
17) For products with a power switch:
The main power switch is located on the back panel of S3. It should remain accessible after installation.
18) The equipment shall be used at a maximum ambient temperature of 40°C.